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Thank You for Choosing Ross

You've made a great choice. We expect you will be very happy with your purchase of Ross
Technology.

Our mission is to:

1. Provide a Superior Customer Experience

· offer the best product quality and support

2. Make Cool Practical Technology

· develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and
empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach
out to us at solutions@rossvideo.com.

David Ross

CEO, Ross Video

dross@rossvideo.com

Ross Video Code of Ethics

Any company is the sum total of the people that make things happen. At Ross, our employees are
a special group. Our employees truly care about doing a great job and delivering a high quality
customer experience every day. This code of ethics hangs on the wall of all Ross Video locations
to guide our behavior:

1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong
and it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required
action in times of company or customer crisis - do what you know in your heart is right. (You
may rent helicopters if necessary.)

mailto:solutions@rossvideo.com
mailto:dross@rossvideo.com
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End User Software License Agreement

This End User Software License Agreement is a legal agreement between you (the “Licensee”) and Ross
Video Limited (“Ross Video”) specifying the terms and conditions of your installation and use of the
Software and all Documentation (as those terms are defined herein).

IMPORTANT:

BY DOWNLOADING, ACCESSING, INSTALLING OR USING THE SOFTWARE AND/OR
DOCUMENTATION AND/OR BY AUTHORIZING ANY THIRD PARTY, INCLUDING WITHOUT
LIMITATION AN INSTALLER OR COMMISSIONER ACTING ON YOUR BEHALF TO DO SO, LICENSEE
AGREES TO THE TERMS OF THIS AGREEMENT AND THE LICENSE GRANTED HEREUNDER SHALL BE
EFFECTIVE AS OF AND FROM SUCH DATE. IF YOU DO NOT WISH TO ACCEPT THE TERMS AND
CONDITIONS OF THIS AGREEMENT, DO NOT DOWNLOAD, ACCESS, INSTALL, REFER TO OR
OTHERWISE USE THE SOFTWARE AND/OR DOCUMENTATION.

1. INTERPRETATION. In this Agreement, (a) words signifying the singular number include the plural and
vice versa, and words signifying gender include all genders; (b) every use of the words "herein",
"hereof", “hereto” "hereunder" and similar words shall be construed to refer to this Agreement in its
entirety and not to any particular provision hereof; (c) reference to any agreement or other document
herein will be construed as referring to such agreement or other document as from time to time
amended, modified or supplemented (subject to any restrictions on such amendment, modification or
supplement set forth therein); (d) every use of the words “including” or “includes” is to be construed as
meaning “including, without limitation” or “includes, without limitation”, respectively; and (e)
references to an Article or a Section are to be construed as references to an Article or Section of or to
this Agreement unless otherwise specified.

2. DEFINITIONS. In this Agreement, in addition to the terms defined elsewhere in this Agreement, the
following terms have the meanings set out below:

“Affiliate” means, with respect to any Person, any other Person who directly or indirectly controls, is
controlled by, or is under direct or indirect common control with, such Person. A Person shall be
deemed to control a Person if such Person possesses, directly or indirectly, the power to direct or cause
the direction of the management and policies of such Person, whether through the ownership of voting
securities, by contract or otherwise; and the term “controlled” and “controlling” shall have a similar
meaning.

“Agreement” means this End User Software License Agreement including the recitals hereto, as the
same may be amended from time to time in accordance with the provisions hereof.

“Backup System” means the secondary piece of Designated Equipment upon which the Software is
installed and mirrored for the sole purpose of replacing a Primary System in the event such Primary
System is not available or functioning properly for any reason.

“Change of Control” means (a) the direct or indirect sale, transfer or exchange by the shareholders of
a Party of more than fifty percent (50%) of the voting securities of such Party, (b) a merger or
amalgamation or reorganization or other transaction to which a Party is party after which the
shareholders of such Party immediately prior to such transaction hold less than fifty percent (50%) of
the voting securities of the surviving entity, (c) the sale, exchange, or transfer of all or substantially all
of the assets of a Party.



“Confidential Information” means all data and information relating to the business and management
of either Party, including the Software, trade secrets and other technology to which access is obtained
or granted hereunder by the other Party, and any materials provided by Ross Video to Licensee;
provided, however, that Confidential Information shall not include any data or information which:

(i) is or becomes publicly available through no fault of the other Party;

(ii) is already in the rightful possession of the other Party prior to its receipt from the other Party;

(iii) is already known to the receiving Party at the time of its disclosure to the receiving Party by the
disclosing Party and is not the subject of an obligation of confidence of any kind;

(iv) is independently developed by the other Party;

(v) is rightfully obtained by the other Party from a third party; or

(vi) is disclosed with the written consent of the Party whose information it is.

“Designated Equipment” shall mean (a) the hardware products sold by Ross Video to Licensee on
which the Software is installed and licensed for use, as the same may be replaced from time to time by
Ross Video; or (b) in the case of Software licensed on a stand-alone basis, the equipment of Licensee
on which the Software is to be installed and meets the minimum specifications set out in the
Documentation.

“Documentation” shall mean manuals, instruction guides, user documentation and other related
materials of any kind pertaining to the Software (whether in electronic, hard-copy or other media
format) that are furnished to Licensee by or on behalf of Ross Video in relation to the Software.

“Freeware” means Software that is available free of charge from Ross Video, and includes, without
limitation the master control system software known as "DashBoard".

"Governmental Authority" means (a) any federal, provincial, state, local, municipal, regional,
territorial, aboriginal, or other government, governmental or public department, branch, ministry, or
court, domestic or foreign, including any district, agency, commission, board, arbitration panel or
authority and any subdivision of any of them exercising or entitled to exercise any administrative,
executive, judicial, ministerial, prerogative, legislative, regulatory, or taxing authority or power of any
nature; and (b) any quasi-governmental or private body exercising any regulatory, expropriation or
taxing authority under or for the account of any of them, and any subdivision of any of them.

“Improvements” means all inventions, works, discoveries, improvements and innovations of or in
connection with the Software, including error corrections, bug fixes, patches and other updates in
Object Code form to the extent made available to Licensee in accordance with Ross Video’s release
schedule.

"License Fee" means the fee(s), if any, payable in respect of the Software in accordance with the
relevant invoice(s) or other purchase documents delivered in connection with this Agreement.

“License Period” means the period of time that Licensee will have the rights granted under this
Agreement, as may be specified in an Order.

“Modifications” means any enhancements, changes, corrections, translations, adaptations, revisions,
developments, upgrades or updates thereto; and “Modify” shall mean the creation of any of the
foregoing.

“Object Code” means the machine readable executable form of a computer software program.



"Open Source Components" means third party Open Source software, libraries or other components.

"Open Source License" means the license that governs each Open Source Component.

"Order" means the documents provided by Ross Video to Licensee detailing the Ross Video products
contemplated for purchase, the corresponding fees and License Period that may apply to the Software,
including any and all quotations, purchase orders, acknowledgments, pro formas, invoices and other
purchase documentation.

“Parties” means both Ross Video and Licensee and “Party” means either one of them as the context
requires.

“Person” will be broadly interpreted and includes (a) a natural person, whether acting in his or her own
capacity, or in his or her capacity as executor, administrator, estate trustee, trustee or personal or legal
representative; (b) a corporation or a company of any kind, a partnership of any kind, a sole
proprietorship, a trust, a joint venture, an association, an unincorporated association, an
unincorporated syndicate, an unincorporated organization or any other association, organization or
entity of any kind; and (c) a Governmental Authority.

“Primary System” means the Designated Equipment upon which the Software is installed and
executed to deliver its intended functionality.

“Released Claims” has the meaning ascribed to it in Section 9(b). 

“Released Parties” has the meaning ascribed to it in Section 9(b). 

“Ross Video” means Ross Video Limited and its Affiliates. 

“Software” means the version of the Object Code licensed and delivered to Licensee by Ross Video
concurrently with delivery of this Agreement, including without limitation the Freeware, and any
subsequent error corrections, updates, Modifications or Improvements provided to Licensee by Ross
Video pursuant to this Agreement, but specifically excluding any features or plug-ins that may be
purchased by you directly from third parties as upgrades or enhancements to the Software.

“Source Code” means the human readable form of a computer software program, and all tools and
documentation necessary for a reasonably competent computer programmer to understand, maintain
and Modify the Software.

“Third Party Software” means those portions of the Software, if any, which are owned or controlled
by third parties and licensed to Ross Video pursuant to certain license agreements or arrangements
with such third parties, including the Open Source Components and NDI®1 software (http://NDI.video);
and

“Use” means to execute, run, display, store, merge, network, Modify, translate, host or integrate with
Licensee’s products or other third party software.

1 NDI® is a registered trademark of Vizrt NDI AB.

http://NDI.video


3. LICENSE. Subject to the terms and conditions of this Agreement, upon payment of the applicable
License Fee by Licensee, or, in the case of Freeware only, upon download of the Software by Licensee
onto its Designated Equipment, Ross Video hereby grants to Licensee a non-transferable and non-
exclusive right to Use the Software and Documentation solely for the internal use of Licensee (the
“License”), during the License Period. In the event that a License Period is not identified on the Order,
such License Period shall be deemed to be perpetual, subject to paragraph 10 (c) of this Agreement.
The Software shall only be used in connection with or installed on the Designated Equipment and,
where applicable, shall only be used on the Primary System, provided such Primary System is operating
properly."

If the Primary System is not operating properly for any reason, the Software may be used on the
designated Backup System for that Primary System until such time that the Primary System begins
operating properly. The Software and Documentation are provided to Licensee for the exclusive use by
Licensee’s organization for its ordinary business purposes and shall not be used by any third party for
any purposes. Licensee may make copies of the Software as required for internal backup and archival
purposes. To the extent permitted hereunder, Licensee may distribute copies of the Software and/or
Documentation to members of its organization, provided (a) this Agreement is included with each copy,
(b) any member of its organization who uses the Software and/or Documentation accepts and agrees to
be bound by the terms of this Agreement and by any other license agreements or other agreement
incorporated by reference into this Agreement, and (c) Licensee has paid any applicable additional
License Fees in respect of copying and redistributing of the Software. To the extent Licensee is
permitted to make copies of the Software under this Agreement, Licensee agrees to reproduce and
include on any copy made or portion merged into another work, all Ross Video proprietary notices,
including any notices with respect to copyrights, trademarks and this License. With the exception of
copying the Software for backup or archival purposes, Licensee agrees to keep a record of the number
and location of all such copies and will make such record available at Ross Video’s request. The
Software may include mechanisms to limit or inhibit copying.

4. LICENSE RESTRICTIONS. Except as otherwise provided in section 3 above, Licensee shall not: (1)
copy any Software or Documentation, or part thereof, which is provided to Licensee by Ross Video
pursuant to this Agreement, in Object Code form, Source Code form or other human or machine
readable form, including written or printed documents, without the prior written consent of Ross Video;
(2) in any way market, distribute, export, translate, transmit, merge, Modify, transfer, adapt, loan,
rent, lease, assign, share, sub-license, sell, make available for download on any website or make
available to another Person, the Software and/or Documentation, in whole or in part, provided that
Licensee shall not be prohibited from renting or leasing the Software if Ross Video has consented, in
writing, to Licensee engaging in such activities in respect of the Software; (3) reverse engineer,
decompile or disassemble the Software or electronically transfer it into another computer language; or
(4) use the Software or Documentation in a manner that is inconsistent with the License granted
hereunder or that will result in a breach of this Agreement. Licensee agrees to take all reasonable
precautions to prevent third parties from using the Software and/or Documentation in any way that
would constitute a breach of this Agreement, including such precautions Licensee would ordinarily take
to protect its own proprietary software, hardware or information.

5. DELIVERY. Ross Video shall deliver to Licensee one (1) master copy of the Software in compiled
binary (executable) form suitable for reproduction in electronic files only and Ross Video shall deliver to
Licensee a minimum of one copy of the Documentation.

6. IMPROVEMENTS. Licensee may from time to time request Ross Video to incorporate certain
Improvements into the Software. Ross Video may, in its sole discretion, undertake to incorporate and
provide such Improvements to Licensee with or without payment of a fee to be negotiated at the time
of such request. All Improvements, whether recommended and developed by Ross Video or Licensee,
shall be considered the sole property of Ross Video and shall be used by Licensee pursuant to the terms
of the License granted under this Agreement.



7. FREEWARE. Other than the obligation to pay a License Fee, which does not apply to the Freeware, all
other provisions of this End User Software License Agreement apply to the Freeware in the same way
as they apply to all other Software that is the subject of this Agreement. In addition, in connection with
the Freeware, the following provisions apply: 

a. Licensee will not Use the Freeware to engage in or allow others to engage in any illegal activity.

b. Licensee will not Use the Freeware in any way that will interfere with or damage the operation of the
services of any third parties by overburdening/disabling network resources through automated
queries, excessive usage or similar conduct.

c. Licensee will not Use the Freeware to engage in any activity that will violate the rights of others,
including, without limitation, by using it for operations that involve child labour, suppressing the
right of freedom of expression or endangering the security of person.

8. OWNERSHIP. The Parties acknowledge and agree that, as between the Parties, Ross Video shall be
the owner of all intellectual property rights in the Software, Documentation and all related Modifications
and Improvements, written materials, logos, trademarks, trade names, copyright, patents, trade
secrets and moral rights, registered or unregistered. No proprietary interest or title in or to the
intellectual property in the Software, Documentation or any Improvements or Modifications is
transferred to Licensee by this Agreement. Ross Video reserves all rights not expressly licensed to
Licensee under section 3.

9. OPEN SOURCE SOFTWARE. 

a. Software may use and/or be provided with Open Source Components, including those detailed in the
Third Party section below. To the extent stipulated by its Open Source License, each such Open
Source Component is licensed directly to Licensee from its respective licensors and not sub-licensed
to Licensee by Ross Video, and such Open Source Component is subject to its respective Open
Source License, and not to this Agreement. If, and to the extent, an Open Source Component
requires that this Agreement effectively impose, or incorporate by reference, certain disclaimers,
permissions, provisions, prohibitions or restrictions, then such disclaimers, permissions, provisions,
prohibitions or restrictions shall be deemed to be imposed, or incorporated by reference into this
Agreement, as required, and shall supersede any conflicting provision of this Agreement, solely with
respect to the corresponding Open Source Component which is governed by such Open Source
License. 

b. If Licensee, or another party on Licensee’s behalf, modifies, replaces or substitutes any Open Source
Component used in or provided with this Software, Licensee hereby fully, forever, irrevocably and
unconditionally releases and discharges Ross Video, its Affiliates and its and their employees,
officers, directors, resellers, distributors and representatives (collectively, “Released Parties”) from
any and all claims, charges, complaints, demands, actions, causes of action, suits, rights, debts,
covenants, liabilities, warranties, performance and maintenance and support obligations
(collectively, “Released Claims”), of every kind and nature, with respect to such Software, including
without limitation any such Released Claims that arise as a matter of applicable Law. 

c. If an Open Source License requires that the source code of its corresponding Open Source
Component be made available to Licensee, and such source code was not delivered to Licensee with
the Software, then Ross Video hereby extends a written offer, valid for the period prescribed in such
Open Source License, to obtain a copy of the source code of the corresponding Open Source
Component, from Ross Video from https://www.rossvideo.com/open-source-information/.

https://www.rossvideo.com/open-source-information/


10. THIRD PARTY SOFTWARE. 

a. Licensee acknowledges that the Third Party Software is not owned by Ross Video. Notwithstanding
any other provision of this Agreement, Ross Video, to the extent permitted by applicable law, offers
no warranties (whether express, implied, statutory or by course of communication or dealing with
Licensee, or otherwise) with respect to the Third Party Software. Ross Video may pass through to
Licensee, if and to the extent permitted by applicable law, any warranties expressly provided by
such third parties to Ross Video for such Third Party Software.

b. FFmpeg Notice. The Software may utilize FFmpeg video components and their included libraries.
FFmpeg is a trademark of Fabrice Bellard (originator of the FFmpeg project). Ross Video disclaims
any ownership claim to FFmpeg. Please refer to http://ffmpeg.org (copyright is in the FFmpeg
developers). FFmpeg is licensed under the GNU Lesser General Public License v2.1 or Lesser General
Public License v3.0. GNU Lesser General Public License contact information: Free Software
Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA. Licensee can
distribute it and/or modify it under the terms of such licenses.

11. INTELLECTUAL PROPERTY INDEMNITY. 

a. Ross Video agrees to defend, indemnify and hold harmless Licensee from final damages awarded by
a court of competent jurisdiction (hereinafter referred to as the “Losses”), which Licensee, or any of
its officers or directors, may incur, suffer or become liable for as a result of, or in connection with,
any third party claim asserted against Licensee to the extent such claim is based on a contention
that the Software, Documentation or any portion thereof, infringes any valid, registered, enforceable
patents, copyrights, trade secrets, trademarks or other intellectual property rights of any third
party, provided that (a) the allegedly infringing Software or Documentation has been used within the
scope of and in accordance with the terms of this Agreement, and (b) Licensee notifies Ross Video in
writing of such claim within ten (10) days of a responsible officer of Licensee becoming aware of
such claim. If the Software, Documentation or any portion thereof is held to constitute an
infringement of a third party’s intellectual property rights, and use thereof is enjoined, Ross Video
shall, at its election and expense, either (i) procure the right to use the infringing element of the
Software or Documentation; or (ii) replace or modify the element of the Software or Documentation
so that the infringing portion is no longer infringing and still performs the same function without any
material loss of functionality. Ross Video shall make every reasonable effort to correct the situation
with minimal effect upon the operations of Licensee.

b. Notwithstanding the above, Ross Video reserves the right to terminate this Agreement and the
License granted hereunder on immediate notice to Licensee, and without liability to Licensee, in the
event that the Software or Documentation constitutes or may, in Ross Video’s determination,
constitute, an infringement of the rights of a third party that Ross Video, in its sole discretion, does
not consider to be affordably remediable.

c. Either party may terminate this Agreement immediately should any Software become, or in either
party's opinion be likely to become, the subject of a claim of infringement of any intellectual
property right and, in such event, there shall be no claim by either Licensee or Ross Video against
the other arising out of such termination, provided that the foregoing shall not apply to a claim for
infringement by Ross Video against Licensee in the event that Licensee is alleged to have infringed
Ross Video's intellectual property rights, in which case Licensee shall remain liable for all
outstanding License Fees and other amounts owing to Ross Video.

d. Notwithstanding the foregoing, Ross Video shall have no liability for any claim of infringement based
on use of other than a current, unaltered release of the Software and/or Documentation available
from Ross Video if such infringement would have been avoided by the use of a current, unaltered
release of the Software and/or Documentation provided that such current, unaltered release
performs substantially in conformity with the specifications set out in the Documentation and was
provided, at no additional cost by Ross Video, to those subscribing for maintenance services for the
Software or Documentation.



12. CONFIDENTIALITY. Each Party shall maintain in confidence all Confidential Information of the other
Party, shall use such Confidential Information only for the purpose of exercising its rights and fulfilling
its obligations under this Agreement, and shall not disclose any Confidential Information of the
disclosing Party to any third party except as expressly permitted hereunder or make any unauthorized
use thereof. Each Party shall disclose the Confidential Information only to those of its employees,
consultants, advisors, and/or subcontractors who have a need to know the Confidential Information.
Each Party shall, prior to disclosing the Confidential Information to such employees, consultants,
advisors and/or subcontractors, obtain their agreement to receive and use the Confidential Information
on a confidential basis on the same terms and conditions contained in this Agreement. The receiving
Party shall treat the Confidential Information of the disclosing Party with the same degree of care
against disclosure and/or unauthorized use as it affords to its own information of a similar nature, or a
reasonable degree of care, whichever is greater. The receiving Party further agrees not to remove or
destroy any proprietary or confidential legends or markings placed upon any documents or other
materials of the disclosing Party. The obligations of confidence set forth in this Agreement shall extend
to any Affiliates that have received Confidential Information of the disclosing Party and shall also cover
Confidential Information disclosed by any Affiliate. The receiving Party shall be responsible for any
actions or omissions of its Affiliates as if such actions or omissions were its own.

Either party may disclose certain Confidential Information if it is expressly required to do so pursuant to
legal, judicial, or administrative proceedings, or otherwise required by law, provided that (i) such Party
provides the other Party with reasonable written notice prior to such disclosure; (ii) such Party seeks
confidential treatment for such Confidential Information; (iii) the extent of such disclosure is only to the
extent expressly required by law or under the applicable court order; and (iv) such Party complies with
any applicable protective or equivalent order.

Each of Ross Video and Licensee (the “Indemnifying Party”, as applicable) agree to indemnify the
other (the “Indemnified Party”, as applicable) for all Losses incurred by the Indemnified Party as a
result of a failure of the Indemnifying Party to comply with its obligations under this Section 12
provided that the Indemnified Party has given prompt notice of any such claim and, to the extent that a
claim may lie against a third party for the unauthorized disclosure of such Confidential Information, the
right to control and direct the investigation, preparation, action and settlement of each such claim and,
further, provided that the Indemnified Party reasonably co-operates with the Indemnifying Party in
connection with the foregoing and provides the Indemnifying Party with all information in the
Indemnified Party’s possession related to such claim and such further assistance as reasonably
requested by the Indemnifying Party.

The Parties acknowledge and agree that any breach of the confidentiality provisions of this Agreement
by one Party may cause significant and irreparable injury to the other Party that is not compensable
monetarily, as well as damages that may be difficult to ascertain, and agrees that, in addition to such
other remedies that may be available at law or in equity, the other Party shall be entitled to seek
injunctive relief (including temporary restraining orders, interim injunctions and permanent injunctions)
in a court of competent jurisdiction in the event of the breach or threatened breach by such party of
any of the confidentiality provisions of this Agreement. The relief contemplated in this Section shall be
available to each Party without the necessity of having to prove actual damages and without the
necessity of having to post any bond or other security. Each Party further agrees to notify the other
Party in the event that it learns of or has reason to believe that any Person has breached the
confidentiality provisions of this Agreement.



13. LIMITATION OF LIABILITY. The limitation of liability provisions of this Agreement reflect an
informed voluntary allocation of the risks (known and unknown) that may exist in connection with the
licensing of the Software or Documentation hereunder by Ross Video, and that voluntary risk allocation
represents a material part of the Agreement reached between Ross Video and Licensee. Should Ross
Video be in breach of any obligation, Licensee agrees that Licensee’s remedies will be limited to those
set forth in this Agreement. No action, regardless of form, arising out of this Agreement may be
brought by Licensee more than twelve (12) months after the facts giving rise to the cause of action
have occurred, regardless of whether those facts by that time are known to, or reasonably ought to
have been discovered by, Licensee.

(A) EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT, THE SOFTWARE AND DOCUMENTATION
ARE PROVIDED “AS IS” AND ROSS VIDEO (I) MAKES NO OTHER REPRESENTATIONS, AND PROVIDES
NO WARRANTIES OR CONDITIONS OF ANY KIND, EXPRESS OR IMPLIED, STATUTORY, BY USAGE OF
TRADE CUSTOM OF DEALING, OR OTHERWISE, AND (II) SPECIFICALLY DISCLAIMS ALL IMPLIED
WARRANTIES INCLUDING ANY IMPLIED WARRANTY OF UNINTERRUPTED OR ERROR FREE OPERATION,
MERCHANTABILITY, QUALITY OR FITNESS FOR A PARTICULAR PURPOSE. ROSS VIDEO DOES NOT
REPRESENT OR WARRANT THAT THE SOFTWARE WILL MEET ANY OR ALL OF LICENSEE’S PARTICULAR
REQUIREMENTS, THAT THE USE AND OPERATION OF THE SOFTWARE WILL OPERATE ERROR-FREE OR
UNINTERRUPTED, THAT ALL PROGRAMMING ERRORS IN THE SOFTWARE CAN BE FOUND IN ORDER TO
BE CORRECTED, OR THAT THE SOFTWARE WILL BE COMPATIBLE WITH OTHER PROGRAMS, SYSTEMS,
AND HARDWARE.

(B) IN NO EVENT SHALL ROSS VIDEO, ITS AFFILIATES AND LICENSORS, AND THEIR RESPECTIVE
DIRECTORS, OFFICERS, EMPLOYEES AND AGENTS, BE LIABLE FOR ANY CLAIM FOR INDIRECT,
CONSEQUENTIAL, SPECIAL, INCIDENTAL, PUNITIVE, EXEMPLARY, AGGRAVATED DAMAGES; LOST
PROFITS, OR LOST REVENUE ARISING FROM OR IN CONNECTION WITH THIS AGREEMENT,
REGARDLESS OF THE FORM OF ACTION, WHETHER IN CONTRACT, OR IN TORT, EVEN IF THE PARTY
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

(C) IN ANY EVENT THE AGGREGATE LIABILITY OF ROSS VIDEO, ITS AFFILIATES AND LICENSORS, AND
THEIR RESPECTIVE DIRECTORS, OFFICERS, EMPLOYEES AND AGENTS, FOR ANY CLAIM FOR DIRECT
DAMAGES WITH RESPECT TO THE SUBJECT MATTER OF THIS AGREEMENT SHALL NOT EXCEED THE
AMOUNT OF THE PURCHASE PRICE PAID TO ROSS VIDEO UNDER THIS AGREEMENT.

14. TERM AND TERMINATION.

(1) Unless terminated earlier in accordance with the terms of this Agreement, the term of this
Agreement shall commence upon Licensee’s first download, access, installation, or other use of the
Software or Documentation and continues until, in the case of Software licensed with Designated
Equipment provided by Ross Video, the earliest of (a) the end of the License Period, or (b) if the
Designated Equipment is assigned or transferred in accordance with this Agreement, the date on
which the Designated Equipment is no longer owned by Licensee;

(2) Either Party shall have the right to terminate this Agreement on notice to the other Party if: 

(a) the other Party fails to pay any fees or other amounts when due hereunder or under any
other agreement between the Parties (or any Affiliates of the Parties, as applicable) in
connection with the Software and/or Designated Equipment and such breach is not cured
within thirty (30) days after written notice of such failure to pay is given to the defaulting
Party by the non-defaulting Party; 

(b) the other Party shall file a voluntary petition in bankruptcy or insolvency or shall petition for
reorganization under any bankruptcy law, consent to an involuntary petition in bankruptcy, or
if a receiving order is given against it under the Bankruptcy and Insolvency Act (Canada) or
the comparable law of any other jurisdiction (and such is not dismissed within ten (10) days);



(c) there shall be entered an order, judgment or decree by a court of competent jurisdiction,
upon the application of a creditor, approving a petition seeking reorganization or appointing a
receiver, trustee or liquidator of all or a substantial part of the other Party’s assets and such
order, judgment or decree continues in effect for a period of thirty (30) consecutive days; or

(d) the other Party shall fail to perform any of the other material obligations set forth in this
Agreement and such default, in the case of a default which is remediable, continues for a
period of thirty (30) days after written notice of such failure has been given by the non-
defaulting Party or, in the case of a non-remediable default, immediately upon notice.

(3) Notwithstanding anything to the contrary contained in this Agreement:

(a) Ross Video may forthwith terminate this Agreement if Licensee is in breach of any of sections
3, 4 or 12 of this Agreement. For greater certainty, in such instances Ross Video shall provide
written notice of such termination as soon as practicable but written notice shall not be a
necessary prerequisite to such termination; and

(b)  in the event of a Change of Control of Licensee, Ross Video shall have the right to terminate
this Agreement and the License granted hereunder upon thirty (30) days’ prior written notice
to Licensee. For greater certainty, Ross Video’s right to terminate in the event of a Change of
Control of Licensee shall continue for a period of six (6) months from the date Licensee
delivers notice of such Change of Control to Ross Video.

(c) Ross Video may terminate the License immediately on the date on which it provides notice to
Licensee, if its agreements for Third Party Software are terminated.

(4) Upon the termination or expiry of this Agreement:

(a) Licensee shall immediately cease and desist all use of the Software and Documentation;

(b) Licensee shall immediately deliver to Ross Video any of Ross Video’s Confidential Information
provided hereunder (including the Software and Documentation) then in its possession or
control, if any, and shall deliver a certificate of an officer of Licensee certifying the
completeness of same;

(c) Licensee shall refrain from further use of such Confidential Information; and

(d) Licensee shall forthwith pay all amounts owing to Ross Video or any of its Affiliates
hereunder.

15. SURVIVAL. The provisions of sections 1, 2, 6, 8, 9, 10, 11, 12, 13, 14, 18, 22, 23, and 24 herein shall
survive the expiry or termination of this Agreement.

16. FORCE MAJEURE. Dates and times by which Ross Video is required to render performance under this
Agreement shall be automatically postponed to the extent and for the period that Ross Video is
prevented from meeting them by reason of events of force majeure or any cause beyond its reasonable
control provided Ross Video notifies Licensee of the commencement and nature of such cause and uses
its reasonable efforts to render performance in a timely manner.

17. ASSIGNMENT. Ross Video may assign this Agreement, or any of its rights or obligations hereunder, in
whole or in part, upon notice to Licensee. Licensee shall not assign this Agreement, or any of its rights
or obligations hereunder, in whole or in part, without the prior written consent of Ross Video, which
consent may not be unreasonably withheld. This Agreement enures to the benefit of and is binding
upon each of the Parties and their respective successors and permitted assigns.



18. GOVERNING LAW. If Licensee acquired the Ross Product(s) in the United States or Canada, the laws
of the state or province where Licensee’s principal place of business is located govern the interpretation
of this Agreement, claims for its breach, and all other claims regardless of conflict of laws principles. If
Licensee acquired the Ross Product(s) in the European Union or the United Kingdom, then the laws of
England and Wales apply. If Licensee acquired the Ross Product(s) in any other country, then the laws
of the Province of Ontario, Canada shall apply.

19. LANGUAGE. The Parties have expressly required that this Agreement and all documents relating
thereto be prepared in English. Les parties ont expressément exigé que cette convention ainsi que tous
les documents qui s’y rattachent soient rédigés en anglais.

20. GOVERNMENT CONTRACTS. If the Software and/or Documentation to be furnished to Licensee
hereunder are to be used in the performance of a government contract or subcontract, the Software
and/or Documentation shall be provided on a "restricted rights" basis only and Licensee shall place a
legend, in addition to applicable copyright notices, in the form provided under the applicable
governmental regulations. For greater certainty, Ross Video shall not be subject to any flow-down
provisions required by any customer of Licensee that is a Governmental Authority unless Ross Video
expressly agrees to be bound by such flow-down provisions in writing.

21. EXPORT AND IMPORT LAWS. Licensee acknowledges and agrees that the Software (including any
technical data and related technology) may be subject to the export control laws, rules, regulations,
restrictions and national security controls of the United States and other applicable countries (the
“Export Controls”) and agrees not to export, re-export, import or allow the export, re-export or import
of such export-controlled Software (including any technical data and related technology) or any copy,
portion or direct product of the foregoing in violation of the Export Controls. Licensee hereby represents
that it is not an entity or person to whom provision of the Software (including any technical data and
related technology) is restricted or prohibited by the Export Controls. Licensee agrees that it has the
sole responsibility to obtain any authorization to export, re-export, or import the Software (including
any technical data and related technology), as may be required. Licensee will defend, indemnify and
hold Ross Video harmless from any and all claims, losses, liabilities, damages, fines, penalties, costs
and expenses (including attorney’s fees) arising from or relating to any breach by Licensee of its
obligations under this Section.

22. AMENDMENT AND WAIVER. No amendment, discharge, modification, restatement, supplement,
termination or waiver of this Agreement or any Section of this Agreement is binding unless it is in
writing and executed by the Party to be bound. No waiver of, failure to exercise or delay in exercising,
any Section of this Agreement constitutes a waiver of any other Section (whether or not similar) nor
does any waiver constitute a continuing waiver unless otherwise expressly provided.

23. SEVERABILITY. Each Section of this Agreement is distinct and severable. If any Section of this
Agreement, in whole or in part, is or becomes illegal, invalid, void, voidable or unenforceable in any
jurisdiction by any court of competent jurisdiction, the illegality, invalidity or unenforceability of that
Section, in whole or in part, will not affect (a) the legality, validity or enforceability of the remaining
Sections of this Agreement, in whole or in part; or (b) the legality, validity or enforceability of that
Section, in whole or in part, in any other jurisdiction.

24. ENTIRE AGREEMENT. This Agreement, and any other documents referred to herein, constitutes the
entire agreement between the Parties relating to the subject matter of this Agreement and supersedes
all prior written or oral agreements, representations and other communications between the Parties.

Updated: November 1, 2023



Warranty and Repair Policy

Ross Video Limited (Ross) warrants its XPression systems to be free from defects under normal use and
service for the following time periods from the date of shipment:

· XPression Server — 12 months

· XPression Software Upgrades — 12 months free of charge

· System and Media hard drives — 12 months

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as
determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the
customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary
loan basis, plug in circuit boards or other replacement parts may be supplied free of charge while defective
items undergo repair. Return packing, shipping, and special handling costs are the responsibility of the
customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or
application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential
damages (including loss of profit). Implied warranties, including that of merchantability and fitness for a
particular purpose, are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

Extended Warranty

For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the
standard warranty period by one year increments. For more information about an extended warranty for
your XPression system, contact your regional sales manager.



Environmental Information

The equipment that you purchased required the extraction and use of natural resources for its production. It
may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the
extraction of natural resources, Ross Video encourages you to use the appropriate take-back systems. These
systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally
friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or
regional waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.



Company Address

Ross Video Limited 

8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 

P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office:

Fax:

(+1) 613 · 652 · 4886

(+1) 613 · 652 · 4425

Toll Free Technical Support: 1-844-652-0645 (North America)

+800 3540 3545 (International)

Alternately, you can contact:

Technical Support: (+1) 613 · 652 · 4886

After Hours Emergency: (+1) 613 · 349 · 0006

E-mail for Technical Support: techsupport@rossvideo.com

E-mail for General Information: solutions@rossvideo.com

Website: http://www.rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information Request&Body=Hi,%0D%0D
mailto:solutions@rossvideo.com?Subject=Information Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Introduction
Pre-rolls are a thing of the past with XPression Clips, a production clip server for live production that
incorporates the latest advances in IT technologies. Built on the industry-leading XPression real-time
graphics platform, XPression Clips offers you instant recall times and back-to-back clip transitions from an
intuitive user interface or via automation triggers from other devices like Ross Video productions switchers. 

You can simultaneously ingest multiple channels of baseband video and output multiple channels of clips to
air. Both NAS and SAN configurations are available for attached storage, in addition to ample local hard
drive space. Database management and synchronization are possible with the Clip Store that supports user
rights and roles. 

You can also add XPression Clips functionality to XPression Studio’s basic clip handling capabilities by adding
the XPression Clips Option.

Key features of XPression Clips and the XPression Clips Option include:

· Multi-channel ingest and playout

· 1, 2, or 4 channels of baseband video ingest

· 2 or 4 channels of playout (user-definable fill/fill or fill/key configuration)

· Back-to-back transitions

· Multiple clips on the same output

· Clip Browser with searching

· Clip trimming and looping

· VDCP, AMP, PBus, and RossTalk automation protocols

· PBus Manager for intelligent clip assignment

· Clip Manager application with user rights for database management and synchronization setup

· NAS or SAN attached storage with SNS storage (Studio Network Solutions)

Streamline your production clips workflow with Ross Video’s next-generation production clip servers and
transcoding applications. Available in multiple configurations, XPression Clips/XPression Clips Option and the
Clip Server Option for XPression Studio bring lightning-fast recall speeds, baseband video ingest, and multi-
layer clip playback to the control room.
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About This Guide

This guide covers the use of the XPression system. 

If, at any time, you have questions pertaining to the operation of XPression, please contact us at the
numbers listed in the section Getting Help. Our technical staff is always available for consultation, training,
or service.

Documentation Conventions

Special text formats are used in this guide to identify parts of the user interface, text that a user must
enter, or a sequence of menus and sub-menus that must be followed to reach a particular command.

Bold text Bold text identifies a user interface element such as a dialog box, menu item, or
button.

For example:

In the Slug column, type a slug name for the story.

Italic text Italic text is used to identify the titles of referenced guides, manuals, or
documents.

For example:

For more information, refer to the DashBoard User Guide.

Courier text Courier text identifies text that a user must type.

For example:

In the Username box, type postgres.

Menu Sequences Menu arrows are used in procedures to identify a sequence of menu items that
you must follow.

For example:

If a step reads Server > Save As, you would select the Server menu and then
select Save As.

Hypertext Identifies a hyperlink to a related topic.
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Getting Help

XPression documentation is available online at Product Documentation and is also accessible on the product
USB key and by selecting the Help icon in the user interface.

Contacting Technical Support

At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as the
nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. After-sales
service and technical support is provided directly by Ross Video personnel. During business hours (Eastern
Time), technical support personnel are available by telephone. After hours and on weekends, a direct
emergency technical support phone line is available. If the technical support person who is on call does not
answer this line immediately, a voice message can be left and the call will be returned shortly. This team of
highly trained staff is available to react to any problem and to do whatever is necessary to ensure customer
satisfaction.

Technical Support:

· 1-844-652-0645 (North America)

· +800 3540 3545 (International)

· After Hours Emergency: (+1) 613-349-0006

· E-mail: techsupport@rossvideo.com

· Website: http://www.rossvideo.com

https://www.rossvideo.com/support/product-documentation
mailto:techsupport@rossvideo.com
http://www.rossvideo.com
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XPression Clips Components and
Workflow Overview
The following components of the XPression Clips workflow are discussed in this section:

XPression Clip Store

XPression

XPression Media Control Gateway

XPression INcoder

Clips Workflow
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XPression Clip Store

The XPression Clip Store is a windows service that serves as the database to hold clips within a clip
workflow. The database contains pointers to the clips on disk as well as all of the metadata associated with
a clip, such as the name, recall ID, in/out points, sub clip info, etc.

The XPression Clip Store can run on any physical machine, but in the basic workflow would generally run on
the XPression machine itself.

The XPression Clip Store has the capability to replicate clips and metadata to other clip stores in the
workflow. For example, if you have several XPression machines and run a local Clip Store on each, then
those clip stores can be kept up to date through automated database/clip syncing. Syncing can also be used
to create a backup Clip Store to use if the primary machine is taken offline (there is no automatic failover).

The XPression Clip Store has users and user rights assignment features to allow users to be created with
permissions to perform different tasks such as trimming, deletion, sync, and administration.

XPression Clip Store Manager

The XPression Clip Store Manager is a user application that connects to the Clip Store service (on a local or
remote machine). The Clip Store Manager is used to administer the users, synchronization settings, and
clips.

Extensive search capabilities for browsing the clips is provided and clips can be deleted from the Clip Store
Manager.
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XPression

The following components are used in the Clips workflow.

If using the XPression Clips Option, the following components are accessed in the XPression Sequencer
mode, with the exception of the Record Client, which can be accessed in the Layout mode as well.

Clip Browser

The Clip Browser is a window in the XPression Sequencer used for dragging and dropping clips into the
Sequencer or Server Channels.

Server Channels

The Server Channels window is located in the XPression Sequencer and is used for previewing and playing
out clips. Clips can also be edited from the Server Channels window.

These channels represent a server channel as on a typical video server. The virtual channels are created in
the Server Channels tab of the Hardware Setup in XPression.

Clip Editor

From the Clip Browser or the Server Channels, a selected clip can be opened in the Edit Clip window for
editing.

PBus Mapping

A PBus Mapping menu exists in the XPression Sequencer to provide additional capabilities to the PBus recall
system. By assigning a PBus device ID to a server channel, clips from the Clip Browser can be assigned to a
PBus register simply by dragging them from the Clip Browser onto a PBus register.

Record Client

Use the Record Client dialog box to record an incoming SDI video as a video file or as a still image.

Up to four streams can be recorded simultaneously, however, each stream affects overall system
performance, so with four streams recording it is unlikely you will be able to playback graphics
simultaneously without dropping frames. Recording to network locations (NAS/SAN) may or may not be
possible depending on the bandwidth available. The number of audio channels to record can be varied
between 0 and 16. Recordings are made to the XPression Video Codec avi format.
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XPression Media Control Gateway

The XPression Media Control Gateway is used to receive AMP or VDCP connections to control XPression with
XPression Clip Store. AMP/VDCP can be received over either TCP or Serial (RS232) connections.

For RS422 support, an external converter must be used.

One Media Control Gateway is required for each XPression machine.

This gateway connects directly to an XPression machine, but also connects to the XPression Clip Store to
retrieve the entire clip list.



Clips Workflow User Guide (v12.5) XPression Clips Components and Workflow Overview • 8

XPression INcoder

The XPression INcoder is a separate, optional component to the XPression Clips workflow. For more
information, or to purchase the INcoder, contact Ross Video.

The XPression INcoder is a windows service that manages one or more watchfolders used for file based
ingest of clips into the XPression Clips workflow. The INcoder performs transcoding functions to convert clips
from compatible formats into XPression Codec AVI files. The same formats supported by the XPression Video
Coder can be transcoded by the INcoder.

For More Information on...

· the XPression INcoder, refer to the XPression INcoder User Guide.
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Clips Workflow

The following diagrams illustrate examples of the XPression Clips workflow options:

Clips Configuration with Synchronized Clip Store Databases

Clips Workflow Using the Record Client

Clips Workflow Using the XPression INcoder

Clips MOS Workflow
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Clips Configuration with Synchronized Clip Store Databases

The following diagram illustrates an example of the XPression Clips workflow setup using synchronized Clip
Store databases in a non-MOS workflow.

Clips Workflow Configuration when Using Multiple Workstations and Synchronized Clip Store Databases
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Clips Workflow Using the Record Client

The following diagram illustrates an example of the XPression Clips workflow setup using the Record Client.

Clips Workflow Configuration when Using a Single Engine and the Record Client
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Clips Workflow Using the XPression INcoder

The following diagrams illustrate examples of the XPression Clips workflow setup using multiple engines on
the XPression INcoder server and using a customer supplied PC.

Clips Workflow Configuration when Using Multiple Engines and the INcoder Server
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Clips Workflow Configuration when Using Multiple Engines and the INcoder on a Customer Supplied PC
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Clips MOS Workflow

The following diagram illustrates an example of the XPression Clips workflow setup using synchronized Clip
Store databases in a MOS workflow.

Clips Workflow Configuration when Using Multiple Workstations and Synchronized Clip Store Databases in a
MOS workflow
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XPression Clip Store Setup
The following topics are discussed in this section:

Installing the XPression Clip Store

Installing an SSL Certificate

XPression Clip Store Manager Interface Overview

Starting and Stopping XPression Clip Store

Starting the Clip Store Manager

Configuring the Clip Store

Adding User Roles

Adding Users

Synchronizing Multiple Clip Stores

Viewing the Transfer Status When Syncing Servers

Browsing and Deleting Clips

Projects

Wiping the Clips Database

Configuring XPression Studio, BlueBox, and Gateway for XPression Clip Store
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Installing the XPression Clip Store

Once XPression has been installed, use the following procedure to install the XPression Clip Store.

To install the XPression Clip Store:

1. Locate and double-click the xpClipStore-X.X_XXXX.exe file.

The Setup - XPression Clip Store page opens.

2. Select Next.

The Select Destination Location page opens.

3. Use the default destination folder location or select Browse to locate and select a different destination
location.



17 • XPression Clip Store Setup Clips Workflow User Guide (v12.5)

4. Select Next.

The Select Components page opens.

5. Select Next.

The Select Start Menu Folder page opens.

6. Use the default Start menu folder location or select Browse to locate and select a different Start menu
location.
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7. Select Next.

The Ready to Install page opens.

8. Select Install.

The installation begins. Once the installation is complete, the Completing the XPression Clip Store
Setup Wizard page opens.

9. Select Finish.

If the Start Clip Store service checkbox is left as selected by default and the installation was
successful, an information box is displayed that indicates that the XPression Clip Store was successfully
started.

For More Information on...

· installing XPression, refer to the XPression Quick Start Guide.
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Installing an SSL Certificate

In order for the XPression Clip Store to operate over SSL/HTTPS connections, an SSL certificate must be
purchased and installed on the XPression Gateway server. This section outlines the steps.

Prerequisites

A purchased SSL certificate from a trusted root authority (our certificates are purchased from DigiCert, so
these instructions will use the steps for DigiCert as an example).

Buying an SSL Certificate

To purchase an SSL certificate, a CSR file must be generated and sent to the certificate authority. The CSR
file describes the server machine that will hold the certificate as well as the Company and Organization
details for the purchaser. This must be generated on the Gateway machine and must be registered against
the server/domain that the Clip Store will use to connect to the gateway.

The CSR can usually be generated using a tool provided by the Certificate Authority (or they should provide
documentation on how to generate the CSR).

When purchasing from DigiCert, the platform can be specified as “Other”. This will provide you with .CRT
files containing the certificates.

Installing the Certificate

DigiCert provides a DigiCert Key Utility that can be used to install the three certificate files (Root,
Intermediate, and the actual gateway certificate).

SSL Certificate from Certificate Authority

Once the certificates have been installed, they must be configured and bound to the port that the XPression
Gateway will use.
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To add the Snap-in:

1. Open Windows MMC by pressing Win+R, typing MMC and pressing Enter.

2. In the Console1 window, from the File menu, select Add/Remove Snap-in.

3. In the Available snap-ins list, double-click Certificates.

SSL - Add/Remove Snap-ins

4. In the Certificates snap-in dialog, select Computer Account and click Next.

SSL - Certificates Snap-in
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5. In the Select Computer dialog, select Local Computer and select Finish.

SSL - Select Computer

6. In the Add or Remove Snap-ins dialog, select OK.

To select the certificate:

1. In the Certificates folder, select Personal > Certificates and find the certificate. 

In this example, it is *.rossvideo.com.

SSL - Select Certificate
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2. Double-click the certificate and go to Details->Thumbprint.

SSL - Certificate Details

3. Copy and paste the thumbprint text to a clipboard or notepad and then close the Certificate dialog.

4. Open the Windows Command Prompt console as administrator and run the following command:

netsh http add sslcert ipport=0.0.0.0:9444 certhash=%thumbprint% appid={B7D308CE-E9CE-
4F75-BBF8-842155CF8638}

where %thumbprint% will be the thumbprint you copied from MMC.

A message should be received indicating successful installation of the certificate.

To remove a certificate from a port:

· Open the Windows Command Prompt console as administrator and run the following command: 

netsh http delete sslcert ipport=0.0.0.0:9444 

Existing bindings must be deleted before a certificate can be reassigned to an existing port.
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To see a list of bound SSL certificates to ports:

· Open the Windows command prompt console as administrator and run the following command: 

netsh http show sslcert 

If the certificate is correctly bound, it will appear as follows:

SSL - Certificate Successfully Bound
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XPression Clip Store Manager Interface Overview

The following screen capture displays the main elements of the XPression Clip Store Manager.

1. Menu Bar — use this menu bar to access the
Server menu.

2. Object Browser — use this area to browse clips,
select a project, add users, define user roles, add
servers in which to sync, and view the status of
transfers.

3. Main Window — use this window to configure or
edit the selected item from the Object Browser.

4. Status Area — displays the current connection
status of the Clip Store.



25 • XPression Clip Store Setup Clips Workflow User Guide (v12.5)

Starting and Stopping XPression Clip Store

XPression Clip Store services are automatically started after installation. However, if the option to start after
install is de-selected or if the service has been stopped at any point, use the following procedure to start the
Clip Store service.

To start the Clip Store:

1. On the machine that has the XPression Clip Store installed, locate the XPression Clip Store folder using
the Start menu.

2. Select Start Clip Store ( ).

If the Clip Store has successfully started, an information message indicates that the XPression Clip Store
was successfully started.

To stop the Clip Store:

1. On the machine that has the XPression Clip Store installed, locate the XPression Clip Store folder using
the Start menu.

2. Select Stop Clip Store ( ).

If the Clip Store has been successfully stopped, an information message indicates that the XPression Clip
Store was successfully stopped.
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Starting the Clip Store Manager

Use the XPression Clip Store Manager to connect to XPression Clip server.

To connect to the XPression Clip server:

1. On the machine that has the XPression Clip Store installed, locate the XPression Clip Store folder using
the Start menu and select Clip Store Manager.

The Connect to Clip Store server dialog opens.

2. In the Server section, in the Host field, enter the IP address of the Clip Store service if using remotely.

OR

If using the Clip Store service locally, select localhost from the drop-down.

This is the server from which the clips will be synchronized.

3. In the Login section, in the User Name field, enter the login name of the user. 

The default user name is admin.

4. In the Password field, enter the password for the user. 

The default password is admin.

5. Select the Save password checkbox to automatically enter the login credentials for subsequent
connections to the Clip Store server.
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6. Select OK.

The XPression Clip Store Manager opens.
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Configuring the Clip Store

In the XPression Clip Store Manager, use the Server Settings section to configure the server details.

To configure the server settings:

1. In the Server Settings section, in the Storage Folder field, enter a file path for the folder where clips
are stored. 

The default file path is D:\ClipStore\Storage.

OR

If the machine does not use a D:\ media drive, the default path will be C:\Program Files (x86)
\XPression Clip Store\Storage\.

If exporting sequencer take items as videos/images to a remote ClipStore, the storage folder of the
remote ClipStore must be shared. The UNC path of the shared folder must be entered in the Storage
Folder field of the ClipStore manager on the sequencer engine.

«If this value is being changed after clips have already been ingested into the system, you will need to

manually copy the contents of the D:\ClipStore\Storage to the new folder. A warning will be presented
to remind you to do so:

The new path should contain three subfolders: Clips, Thumbnails, and Flipbooks.

The Clip Store must be restarted after changing the storage folder location.

2. In the TCP Port field, enter or select the port number for the Clip Store server connection. 

The default is 9595.

To configure Recall ID Options:

1. In the Recall ID Options section, select the Allow same Recall ID to be used in different projects
checkbox to use the same recall ID of a clip throughout different projects. 

If selected, the On duplicate recall ID drop-down will adjust to indicate (in same project).

When syncing between Clip Stores, all systems must have this option configured identically.

2. From the On duplicate recall ID drop-down, select an option for handling incoming clips with a
duplicate recall ID:

· remove recall ID from existing clip — remove the recall ID from the clip already stored on the
server.

· delete existing clip when it has no subclips — delete a duplicate clip from the server if it has had
no subclips created from it.

· delete existing clip and subclips — delete a duplicate clip and its subclips from the server.
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To configure General Server Information:

1. In the General Server Information section, in the Name field, enter a name for the Clip Store server,
if necessary. 

The default name is XPression Clip Store.

2. In the Location field, enter the name of the location where the Clip Store server is located, if necessary.

3. In the Description field, enter a brief descriptor for the Clip Store server, if necessary.

To configure the HTTP Server settings:

1. In the HTTP Server section, select the Enable HTTP Server checkbox to enable an HTTP server that
provides a REST interface for retrieving clip information from the Clip Store.

2. In the HTTP Port field, enter or select the port number for the connection. 

The default port is 9550.

3. Select the HTTPS / SSL checkbox to use HTTPS / SSL. 

This requires a pre-installed SSL certificate.

When HTTPS / SSL is enabled, the port number is fixed to 9444.

4. Select OK to apply the Clip Store settings.
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Adding User Roles

Use the XPression Clip Store Manager to add user roles to allow and disable specific functions for specific
roles that are assigned to users.

To add a user role:

1. Connect to the XPression Clip Store Manager.

2. In the Object Browser, select User Roles from the Clip Store menu tree.

The User Roles section opens in the main window.

An Administrator role already exists by default.

3. Right-click inside the User Roles list and select New from the shortcut menu.

The New User Role dialog opens.

4. In the New User Role dialog, enter the following information:

· Name — enter a name for the new user role. For example, if a user is being given deletion rights, a
user role could be given the name ‘Delete’.

· Description — enter a brief descriptor for the user role, if necessary.
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5. In the Rights section, use the checkboxes to select the rights allowed for the user role:

Trim — this feature will be available in a future release.

Delete — ability to delete clips.

Sync — ability to synchronize servers.

Sync users also require delete rights if deletes are to be synchronized across Clip Stores.

Administrator — ability to access all rights.

6. Select OK.

The new user role is added to the User Roles list.

7. Repeat steps 3 to 6 for any other new roles.



Clips Workflow User Guide (v12.5) XPression Clip Store Setup • 32

Adding Users

Use the XPression Clip Store Manager to add users and assign specific user roles that allow and disable
specific functions.

To add a user:

1. Connect to the XPression Clip Store Manager.

2. In the Object Browser, select Users from the Clip Store menu tree.

The Users section opens in the main window.

An Admin user already exists by default.

3. Right-click inside the Users list and select New from the shortcut menu.

The New User dialog opens.
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4. In the User tab of the New User dialog, enter the following information: 

· In the Credentials section, in the Login field, enter a login credential for the new user.

· In the Password field, enter a password for the new user.

· In the Verification field, re-enter the password.

· In the Information section, in the Name field, enter the name of the new user. 

A name must be entered to create a new user.

· In the Department field, enter the name of the department of the new user, if necessary.

· In the Email field, enter the email address of the new user, if necessary.

· In the Phone field, enter the phone number of the new user, if necessary.

· In the Description field, enter a brief descriptor for the user, if necessary.

5. Select OK.

The new user is added to the Users list.

6. Repeat steps 3 to 5 to add more new users.
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To assign a role to a user:

1. Select the Roles tab.

The Roles tab opens.

2. In the Roles tab, select a role in the Available Roles list.

3. Then select Assign.

The role is added to the User Assigned Roles list.

4. Repeat steps 2 and 3 for any other available roles, if necessary.

5. Select OK.

For More Information on...

· adding user roles, refer to Add User Roles.
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Synchronizing Multiple Clip Stores

Use the Sync Servers section to synchronize multiple Clip Stores. A sync server is a server that has clips
pushed to it. 

Synchronizing multiple Clip Stores will ensure that any changes and edits to a clip, or sub-clips created from
a clip, will be reflected across all Clip Stores that have been synced.

To synchronize multiple clip stores:

1. Connect to the XPression Clip Store Manager.

2. In the Object Browser, select Sync Servers from the Clip Store menu tree.

The Sync Servers section opens in the main window.

The New Sync Server dialog opens.
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3. In the New Sync Server dialog, set up the server from which the clips will be synchronized:

· Name — enter the name of the sync server. The default name is Sync Server.

· Host — enter the IP address of the sync server.

· Port — enter the port number of the sync server. The default is 9595.

· Login — enter the login username for the sync server.

· Password — enter the login password for the sync server.

· Description — enter a brief descriptor for the sync server, if necessary.

· Enabled — activate the individual sync server. This is enabled by default.

· Skip Deleted Clips — skip deleted clips when synchronizing.

· Continue On Failure — continue clip sync after a clip fails to sync.

4. In the Project Filter section, select the Sync All Projects checkbox to sync all projects to a destination
Clip Store or de-select it to choose specific projects to sync to a destination Clip Store. 

It is selected by default.

5. Select the Check All button to select all projects in the project list. Select the Uncheck All button de-
select all projects in the project list.

6. Select OK.

The New Sync Server dialog closes and the new sync server is added to the Sync Servers list.

7. Repeat steps 3 to 6 to synchronize other servers, if necessary.

For More Information on...

· connecting to the XPression Clip Store server, refer to Stating the Clip Store Manager.

· viewing the transfer status when syncing servers, refer to Viewing the Transfer Status When Syncing
Servers.
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Viewing the Transfer Status When Syncing Servers

Use the Transfer Status section to view the current progress when synchronizing Clip Stores.

Open it by selecting Transfer Status from the Clip Store menu tree in the Object Browser.

The transfer of files can take a while depending on the amount of files.

The following topics are discussed in this section:

Receiving Files on a Synced Server

Outgoing Files from a Clips Server
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Receiving Files On a Synced Server

When receiving files from a server, the Receiving File list will display the files as they are transfered:

Only one file at a time is listed. The following file information is displayed:

· Receiving File (read-only) — displays the name of the file being received.

· Size (read-only) — displays the file size of the file being received.

· Progress (read-only) — displays a progress status bar and percentage completed for the file being
received.

· Speed (read-only) — displays the speed of the download in MB/s.

· Server (read-only) — displays the IP address of files received.

During the incoming transfer, the Outgoing Sync Engine section will display the Engine Status as Idle.
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Outgoing Files from a Clips Server

When files are being pushed to a synced server, the Outgoing Sync Engine section displays the outgoing
file transfer progress:

The following information is displayed:

· Engine Status (read-only) — displays the current status of the outgoing sync engine:

Ø Idle — the outgoing sync engine is not currently processing any files.

Ø Syncing — the outgoing sync engine is processing a file.

· Server (read-only) — displays the name and address of the server being synchronized.

· Files Remaining (read-only) — displays the remaining number of files to be synchronized.

· Speed (read-only) — displays the speed in MB/s of the file processing.

· Current File (read-only) — displays the name of the file being processed.

· File Size (read-only) — displays the size of the file being processed.

· File Progress (read-only) — displays a progress status bar and percentage completed for the file being
processed.
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Browsing and Deleting Clips

Use the Clips section to browse and delete clips from the server. Use the Clips list to browse for specific
clips, view the clip details, and delete clips from the server.

To open the Clips section:

· In the Object Browser, select Clips from the Clip Store menu tree.

To delete a clip:

· Right-click a clip and select Delete from the shortcut menu.
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Clips List

The following section describes the Clips list interface.

# (read-only) — list number in the Clip Browser list.

Name (read-only) — lists the name of the clip.

In Point (read-only) — lists the drop frame timecode starting point for the clip.

Out Point (read-only) — lists the drop frame timecode ending point for the clip.

Length (read-only) — lists the drop frame timecode duration of the clip.

Format (read-only) — lists the formatting used for the clip.

Thumbnail (read-only) — provides a thumbnail image of the clip or still. Thumbnails can be enlarged by
clicking and dragging the right border of the thumbnail column title. Review a flip book playout of the clip by
hovering the cursor over the thumbnail. The flip book is rendered over a checkerboard pattern so that the
alpha channel is visible unless the clip is full frame. Still image thumbnails display an icon ( ) indicating
that they are still images and not clips.

Flags (read-only) — if using clips that have been transcoded by the XPression INcoder that include tags in
the filename, this column lists the tags that have been parsed from the filename of the clip. The possible
flags include:

· LE — indicates that looping has been enabled.

· HF — indicates that the clip will hold the last frame.

· PM — indicates that the clip uses premultiplied/shaped video.

Audio Ch (read-only) — lists the amount of audio channels embedded in the clip.

Bit Depth (read-only) — lists the quality of the signal quantization for the clip.

Recall ID (read-only) — lists the ID number for the clip when it is recalled.

Project (read-only) — lists the name of the project to which the clip has been added.

Added (read-only) — lists the date the clip was added to the project.

Expires (read-only) — lists the expiry date for the clip, if applicable.

Codec (read-only) — lists the codec format of the clip.

File Ext (read-only) — lists the file type of the clip.

Source (read-only) — lists the location on the server where the clips are stored.

File Size (read-only) — lists the file size of the clip in MB.

Unique ID (read-only) — lists the unique identification assigned to the clip when it was transcoded.

Alpha (read-only) — provides a thumbnail of the clip with the alpha channel visible (if the original status
indicates <no info>, then re-ingest the original clip or update the thumbnail in the Edit Clip/Add Sub Clip
dialog box).

First Frame TC (read-only) — lists the timecode at the point of the first frame of the clip.

Volume (read-only) — lists the volume level of the clip in decibels.
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Has Proxy (read-only) — lists whether the clip includes a proxy or not.
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Search

The following section describes the Search interface of the Clips section.

Name — enter the name of a clip to search.

Recall ID — enter a recall ID to search.

Source — enter a location to search for a clip.

Duration Min — enter a minimum duration time to search for the clip.

Duration Max — enter a maximum duration time to search for the clip.

Project — select a project to search for the clip.

Added Min — use the calendar to select a minimum date to search that the clip was added.

Added Max — use the calendar to select a maximum date to search that the clip was added.

Expires Min — use the calendar to select the minimum expiry date to search for the clip.

Expires Max — use the calendar to select the maximum expiry date to search for the clip.

Never Expires — select this checkbox to search for a clip with no expiry date set.

Audio Ch Min — enter or select a minimum amount of embedded audio channels to search for the clip.

Audio Ch Max — enter or select a maximum amount of embedded audio channels to search for the clip.

No Audio — select this checkbox to search for a clip with no embedded audio.

Reset — clear all the fields in the Advanced Search Options.

Show all sub clips for matching clips — select to display any sub clips of a clip in the Clips list.
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Projects

Use the Projects section to create, edit, and delete projects.

To create a new project:

1. In the Object Browser, select Projects from the Clip Store menu tree.

2. Right-click inside the Projects list and select New Project from the shortcut menu.

The New Project dialog opens.

3. In the Name field, enter a name for the new project.

4. Select OK.

The new project is added to the Projects list.

To edit a project:

1. Select a project in the Projects list.

2. Right-click and select Edit Project from the shortcut menu.

3. The Edit Project dialog opens.
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4. In the Name field, edit the name of the project.

5. Select OK.

The edited project name is updated in the Projects list.

To delete a project:

1. Select a project in the Projects list.

2. Right-click and select Delete Project from the shortcut menu.

A warning prompt opens.

3. Select Yes.

The project is deleted from the Projects list.

Projects List

The following section describes the Projects interface.

# (read-only) — list number in the Projects list.

Name (read-only) — lists the name of the project.

Number of Clips — displays the number of clips in the project.
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Wiping the Clips Database

If the clips database needs to be deleted, there is an option in the Clip Store Manager to permanently
wipe the clips database.

To permanently wipe the clips database:

1. Connect to the XPression Clip Store Manager.

2. Select Server > Advanced > Wipe clips and database.

3. A confirmation dialog opens.

4. Select Yes.

A notification about the deletion opens.

5. Select Yes.

The Clips database is wiped.
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Configuring XPression Studio, BlueBox, and Gateway for
XPression Clip Store

Once XPression Clip Store has been configured using the Clip Store Manager, depending on the workflow,
the following need to be set up for use with the Clip Store:

XPression Studio

XPression BlueBox

XPression Gateway
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XPression Studio

To set up XPression Studio for use with the Clip Store:

1. Open XPression.

2. In XPression, select Edit > Clip Store Setup.

The Clip Store Setup dialog opens.

3. In the Hostname field, enter the IP address of the Clip Store service if using remotely. 

OR

If using the Clip Store service locally, use localhost (default).

4. In the Port field, enter or select the port number for the Clip Store server connection. 

The default is 9595.

5. Select OK.

XPression Studio is now connected to the Clip Store service.
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XPression BlueBox

To set up XPression BlueBox for use with the Clip Store:

1. Start the XPression BlueBox Service if not already started.

2. In the Windows toolbar, right-click the XPression BlueBox icon ( ) and select Clip Store Setup from
the menu.

The Clip Store Setup dialog opens.

3. In the Hostname field, enter the IP address of the Clip Store service if using remotely. 

OR

If using the Clip Store service locally, use localhost (default).

4. In the Port field, enter or select the port number for the Clip Store server connection. 

The default is 9595.

5. Select OK.

XPression BlueBox is now connected to the Clip Store service.
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XPression Gateway

With a Clip Store configured on the XPression Gateway, the XPression MOS Plugin offers the ability to
browse, preview, and select clips as MOS items to include in an NRCS running order. It integrates with the
XPression output and preview engines and the Remote Sequencer.

To set up the XPression Gateway for use with the Clip Store:

1. Open the XPression Gateway.

2. In the XPression Gateway, select Gateway > Settings.

The XPression Gateway - Settings dialog opens.
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3. Select Clip Store to configure the Clip Store Server and settings to use XPression Clips in the MOS
workflow.

The Clip Store configuration area opens.

4. In the Clip Store Server section, select the Enabled checkbox to use the Clip Store Server in the MOS
workflow.

5. In the Host field, enter the IP address of the Clip Store Server.

6. In the Port field, enter or select the port number for the Clip Store Server.

7. Select the Use HTTPS / SSL checkbox to enable the use of HTTPS/SSL in the HTTP Server
configuration. 

Selecting this option requires a pre-installed SSL certificate.

8. Select the Resolve hostname before sending to plugins checkbox to resolve the ClipStore hostname
to an IP before being provided to the client plugins.

9. In the Clips Settings section, from the Default Channel drop-down, select the default engine and
channel to which the clips will be assigned.

10.Select the Clips added to running order should be recalled via their Recall ID to recall clips by
their Recall ID rather than their name. 
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XPression Media Control Gateway
This section contains the following topics:

XPression Media Control Gateway Overview

Installing the XPression Media Control Gateway

Media Control Gateway Interface Overview

Opening the XPression Media Control Gateway Settings Dialog Box

Configuring the General Settings

Configuring the AMP Settings

Supported AMP Commands

Configuring the VDCP Settings

Supported VDCP Commands
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XPression Media Control Gateway Overview

The XPression Media Control Gateway can be used for cueing and playback of clips and subclips from a Clip
Store and for cueing and playback of take items from the XPression Sequencer.

The AMP/VDCP channels correspond to the server channels in XPression. The format for the naming of the
clips/take items can be configured in the XPression Media Control Gateway - Settings dialog. This
format must ensure that every item is uniquely identified – duplicates will not be reported in the list of items
retrieved by the remote device.

Clip and subclip formats support the following tags:

· %NAME% 

· %FILENAME% 

· %ID% 

· %GUID% 

The take item format supports the %ID% tag. Widths can be specified with a colon. For example %NAME:35%

to limit the name to 35 characters, or %ID:4% to use a 4-digit ID padded with 0s.

VDCP/AMP support basic item cueing, as well as cueing with specific in and out points. Playback support
includes jog, shuttle, and variable speed playback. VDCP/AMP also support recording of clips, which will be
directly added to the XPression Clip Store upon a successful record.

The AMP protocol also supports retrieving thumbnails of the clips (when supported by the remote device).

«Deleting and renaming items in the Clip Store or the XPression Sequencer is not supported by the

gateway.
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Installing the XPression Media Control Gateway

To install the XPression Media Control Gateway:

1. Locate and double-click the xpMediaControlGateway-X.X_XXXX.exe file.

The Setup - XPression Media Control Gateway page opens.

2. Select Next.

The Select Destination Location page opens.
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3. Use the default destination folder location or select Browse to locate and select a different destination
location and then select Next.

The Select Components page opens.

4. Select Next.

The Select Start Menu Folder section opens.
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5. Use the default Start menu folder location or select Browse to locate and select a different Start menu
location and then select Next.

The Select Additional Tasks page opens.

6. Select or de-select the Create a Startmenu Icon checkbox and select Next.

The Ready to Install page opens.



57 • XPression Media Control Gateway Clips Workflow User Guide (v12.5)

7. Select Install.

The installation begins.

Once the installation is complete, the Completing the XPression Media Control Gateway Setup
Wizard page opens.

8. Select Finish.

If the Run XPression Media Control Gateway checkbox is left as selected by default, the XPression
Media Control Gateway launches.
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Media Control Gateway Interface Overview

The following screen capture displays the main elements of the Media Control Gateway interface.

1. File Menu — use this list to access the Media Control Gateway settings or shutdown the gateway.

2. Log — displays the activity of the Media Control Gateway.

3. Connections — displays the connections and their respective status.
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Opening the XPression Media Control Gateway Settings

To open the XPression Media Control Gateway Settings:

1. Launch the XPression Media Control Gateway.

The XPression Media Control Gateway opens.

2. Select File > Settings.

The XPression Media Control Gateway - Settings dialog opens.
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Configuring the General Settings

To configure the General settings:

1. In the XPression Media Control Gateway, select File > Settings.

The XPression Media Control Gateway - Settings dialog opens.

2. In the General tab, in the XPression Engine section, configure the following settings:

· In the Host field, enter the IP address of the XPression machine to which the gateway is to connect. 

OR

· Enter localhost to connect the gateway to the local XPression machine. 

The default setting is localhost.

· In the Port field, enter or select the port number of the XPression machine. 

The default is 8001.

3. In the Misc section, make the following selections as necessary:

· Start With Windows — select to start the gateway when Windows launches.

· Log Commands — select to log the commands in the gateway.

· Enable TCP Keep Alive — select to prevent the TCP connection from breaking during periods of
inactivity.

· Log Status Requests — select to log the status requests in the gateway.

· Disable Live Log — select to prevent logs being sent to the Live Log.
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4. In the ID / Name Format section, do the following:

· In the Clip ID Format field, enter the format for the naming of the clips in the gateway.

· In the Sub Clip ID Format field, enter the format for the naming of the subclips in the gateway.

· Select the Include Sub Clips checkbox to include subclips in the clip list. 

This is enabled by default.

· In the Take ID Format field, enter the format for the naming of take IDs in the gateway.

· Select the Include Take IDs checkbox to include take IDs from the XPression sequencer in the clip
list. 

This is enabled by default.

5. In the Clip Store Filter section, select the Filter Clips By Project checkbox to only retrieve clips from
a specified project. 

Enter a project name in the text field from which to retrieve clips.

6. In the Commands section, select the Prevent the Pause command from forcing clip to output
checkbox to prevent the clip from going to output when pause commands are received from a device.

When this checkbox is selected, the Cue video clips directly to framebuffer checkbox in the Options
tab of the Server Channels must not be selected for this preference to function.

7. Select OK.

The XPression Media Control Gateway - Settings dialog closes.
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Configuring the AMP Settings

To configure the AMP settings:

1. In the XPression Media Control Gateway, select File > Settings.

The XPression Media Control Gateway - Settings dialog opens.

2. Select the AMP tab.

The AMP tab opens.
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3. Configure the AMP connection settings as required:

AMP Over TCP/IP

· In the AMP over TCP/IP section, the Server Port field displays the port number for the TCP/IP
server connection. 

The default is 3811 and is not user-configurable.

· Select the Accept AMP CMDS commands with incomplete last byte to accept CMDS commands
with an incomplete last ASCII byte.

OR

AMP Over RS232

· In the AMP over RS232 section, select Add to add a port for the RS232 connection.

The Select RS232 Port dialog opens.

· From the Port drop-down, select a COM port for the connection and select OK.

The COM port is added to the AMP over RS232 connections list.

· Configure the connection settings if necessary:

Ø Port — select a different COM port if necessary.

Ø Baudrate — select a communication speed for GPI signals.

Ø Data Bits — select the number of bits used to represent one character of data for GPI signals.

Ø Parity — select the method used to check for lost data in a GPI signal.

Ø Stop Bits — select the number of bits used to indicate the end of a byte in a GPI signal.

Ø Flow Control — select the data transmission rate controller for a GPI signal.
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Ø Enabled — select whether the AMP over RS232 connection is enabled or not.

Ø Channel — from the drop-down, select a server channel for playout.

When using TCP/IP, the channel corresponding to the server channel in XPression is specified by the
remote device when establishing a connection. However, when using RS232, there is no such provision
in the protocol, so the server channel needs to be specified.

4. In the AMP Recording section, select Add to select a source input if using AMP recording with the
Record Client.

The Select Video Channel # dialog box opens.

5. From the Channel drop-down, select a server channel to use for the AMP session and select OK.

The server channel is added to the AMP Recording list.

6. Click in the Record Input column and from the drop-down, select an input for recording functionality. 

The default is Input 1.

When the AMP connection is configured to control a certain server channel, if this channel is associated
with an input, then the AMP session will have playback control on the server channel and record control
on the input. If the channel is not mapped to an input, then the AMP session will only have playback
control.

Successful recordings are automatically added to the Clip Store.

7. Select the Allow RECORD without CUE checkbox to crash record from AMP when the RECORD
command is received without the CUE command.

8. In the Clip Name field, enter the name of the clip to crash record using the RECORD without CUE
function.

9. Select OK.

The XPression Media Control Gateway - Settings dialog closes.
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Supported AMP Commands

Cueing and playback control on output ports of clips in Clip Store and take items in the Sequencer is
supported, as well as recording on input ports. Clip management, such as renaming, deleting, or modifying
clips, is not supported. Delayed commands are also not supported. The option to send a list of clips to
certain commands (e.g. IN PRESET) is not supported.

The following AMP commands are supported by the XPression Media Control Gateway:

STOP

PLAY

RECORD

EJECT

FAST FORWARD

JOG FORWARD/REVERSE

VARIABLE FORWARD/REVERSE

SHUTTLE FORWARD/REVERSE

REWIND

CUE UP WITH DATA

IN PRESET

OUT PRESET

STATUS SENSE

CURRENT TIME SENSE

RECORD CUE UP WITH DATA

GET THUMBNAIL

LIST FIRST ID

LIST NEXT ID

ID LOADED REQUEST

ID DURATION REQUEST

SET RECORD DURATION

ID START TIME REQUEST

ID COUNT REQUEST

DEVICE NAME REQUEST
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Configuring the VDCP Settings

To configure the VDCP settings:

1. In the XPression Media Control Gateway, select File > Settings.

The XPression Media Control Gateway - Settings dialog opens.

2. Select the VDCP tab.

The VDCP tab opens.
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3. Configure the VDCP connection settings as required:

VDCP Over TCP/IP

· In the VDCP over TCP/IP section, in the Server Port field, enter or select the port number for the
TCP/IP server connection. 

The default is 9091.

OR

VDCP Over RS232

· In the VDCP over RS232 section, select Add to add a port for the RS232 connection.

The Select RS232 Port dialog opens.

· From the Port drop-down, select a COM port for the connection.

· Select OK.

The COM port is added to the VDCP over RS232 connections list.

· Configure the connection settings as necessary:

Ø Port — select a different COM port if necessary.

Ø Baudrate — select a communication speed for GPI signals.

Ø Data Bits — select the number of bits used to represent one character of data for GPI signals.

Ø Parity — select the method used to check for lost data in a GPI signal.

Ø Stop Bits — select the number of bits used to indicate the end of a byte in a GPI signal.

Ø Flow Control — select the data transmission rate controller for a GPI signal.

Ø Enabled — select whether the VDCP over RS232 connection is enabled or not.
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4. Select the Loop commands checkbox to use a VDCP extension to turn looping on (0x1X 0xF1) and off
(0x1X 0xF2). 

This option is disabled by default.

5. Select the CUE/INIT when CUE/INIT DONE is set checkbox to only if the VDCP controller does not
support having both the CUE/INIT and CUE/INIT DONE flags asserted simultaneously (playback or
record). 

This option is disabled by default.

6. Select OK.

The XPression Media Control Gateway - Settings dialog closes.
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Supported VDCP Commands

Cueing and playback control on output ports of clips in Clip Store and take items in the Sequencer is
supported, as well as recording on input ports. Clip management, such as renaming, deleting, or modifying
clips, is not supported. Also, timeline and macro commands are not supported.

The following VDCP commands are supported by the XPression Media Control Gateway:

Immediate commands:

STOP

PLAY

RECORD

STILL

CONTINUE

STEP

JOG

VAR PLAY

Preset commands:

CLOSE PORT

SELECT PORT

PLAY CUE

PLAY CUE WITH DATA

RECORD INIT

Sense commands:

PORT STATUS

OPEN PORT

ID LIST

ID ADDED LIST

ID DELETED LIST

NEXT

ACTIVE ID REQUEST

POSITION REQUEST

ID SIZE REQUEST

ID REQUEST

DEVICE TYPE REQUEST
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XPression INcoder
The XPression INcoder is a separate, optional component to the XPression Clips workflow. If the INcoder has
not been purchased, use the Record Client feature in XPression to transcode clips. For more information, or
to purchase the INcoder, contact Ross Video.

The following topics are discussed in this section:

XPression INcoder Overview

INcoder User Interface Overview

Configuring the XPression INcoder

XPression INcoder Tasks
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XPression INcoder Overview

The XPression INcoder is a windows service that manages one or more watchfolders used for file based
ingest of clips into the XPression Clips workflow. The INcoder performs transcoding functions to convert clips
from compatible formats into XPression Codec AVI files. The same formats supported by the XPression Video
Coder can be transcoded by the INcoder. Still images can be exported to the Clip Store in their native
format.

After clips have been dropped into a watchfolder, an email based notification system can alert configured
users to status events such as failures or successful transcodings.

The XPression INcoder Manager is used for managing and configuring the INcoder service. The INcoder
Manager can run on the INcoder machine or connect to a remote INcoder.

INcoder Terminology

There are several pieces of terminology to understand in the INcoder Manager necessary for configuring it.

Source — a source represents a watchfolder where clips can be placed to be transcoded. The watchfolder
can exist on a local or accessible network drive.

Project — an abstract concept used for grouping clips. A watchfolder should be assigned a project.
Examples of projects could be: news, sports, weather, etc. Separate watchfolders could be assigned for each
project so that clips dropped into a particular folder on disk will be assigned the correct project which can
later be used for searching or clerical tasks. Each project can have separate lists of users to notify.

Target — a target represents the destination to which the transcoded clip should be sent. In the case of
XPression Clips, the target would be an XPression Clip Store. After a successful transcode the clip will be
sent to all of the targets assigned to the processor.

Processor — a processor represents a collection of targets. Each source (watchfolder) must be assigned a
processor. After transcoding, all targets in the processor will receive the final clip.

For More Information on...

· the XPression INcoder, refer to the XPression INcoder User Guide.
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INcoder User Interface Overview

This section provides a user interface overview for the XPression INcoder Manager interface.

The following user interfaces are discussed in this section:

The XPression INcoder - Tasks Tab

The XPression INcoder - Configuration Tab
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The XPression INcoder - Tasks Tab

The following screen capture displays the main elements of the Tasks tab in the XPression INcoder
Manager.

1) Menu Bar — use the Manager menu to exit
XPression INcoder.

2) INcoder Engines — view the configured
engines for XPression INcoder along with their
state and details.

3) Tasks — view the list of clips that are transcoded
and transcoding for specific INcoder engines, as
well as the details about the transcoding.

4) Task Details — feature currently not
implemented.

The XPression INcoder - Configuration Tab

The following screen capture displays the main elements of the Configuration tab in the XPression
INcoder Manager.
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1) Menu Bar — use the Manager menu to exit
XPression INcoder.

2) INcoder Engines — view the configured
engines for XPression INcoder along with their
state and details.

3) Configuration Tabs — use the configuration tabs
to configure the INcoder engines, users, projects,
targets, processors, and sources.

4) Configuration Area — use the configuration area
to configure the settings and details for the
selected configuration tab.
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Configuring the XPression INcoder

Use the XPression INcoder Manager to configure the XPression INcoder for use with XPression Clips.

To configure the XPression INcoder:

1. On the machine that has the XPression INcoder installed, locate the XPression INcoder folder using the
Start menu.

2. Select Start INcoder ( ) if the INcoder has not been started.

If the INcoder has successfully started, an information message indicates that the XPression INcoder was
successfully started.

3. From the XPression INcoder folder, select INcoder Manager.

The XPression INcoder Manager opens.
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4. Select the Configuration tab. 

The Configuration tab opens.

5. Configure the tabs from right to left:
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Engine

Use the following procedure to add and configure as many INcoder engines as needed.

To add a new XPression INcoder engine:

1. In the Configuration Manager, go to the Engine tab.

The Engine tab opens.
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2. Select Add.

An engine is added to the INcoder Engines list.

3. Configure the Engine section:

· In the Name field, enter a name for the INcoder engine. 

The default name is INcoder Engine 1.

· In the Location field, enter the location of the INcoder engine.

· In the Description field, enter a brief descriptor for the INcoder engine.

· In the Host field, enter the IP address of the INcoder service if using remotely. 

If using the INcoder service locally, enter localhost.

· In the Port field, enter or select the port number for the INcoder service connection. 

The default is 9797.

4. Configure the Mail Server section:

· In the Login field, enter the user ID for access to the mail server.

· In the Password field, enter the password for the login user name. 

«Consult your system administrator if you are uncertain of the login credentials.

· In the Host field, enter the IP address of the mail server.

· In the Port field, enter or select the port number for the mail server connection. 

The default is 25.
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· In the Sender Name field, enter a name for the sender of INcoder task status notifications.

· In the Sender E-Mail field, enter the email address of the status information's originator.

5. In the Options section, in the Simultaneous Transcodes field, enter or select the number of video files
that can be transcoded by the INcoder simultaneously. 

Any videos beyond this amount will be queued until other video files have been transcoded.

«Any time the number of transcodes is reduced, the INcoder must be stopped and restarted for the new

Simultaneous Transcodes setting to take effect.

«Currently, a maximum of eight Simultaneous Transcodes are available. However, the number of

simultaneous transcodes should not be set higher than the number of CPU cores available on the
machine.

6. Select OK to apply the settings.

The Engine settings are updated in the INcoder Engines list, and the State is Connected.

7. Repeat this procedure for as many engines as needed.
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Users

Use the following procedure to add and configure as many INcoder users as needed.

To add a new XPression INcoder user:

1. In the Configuration Manager, go to the Users tab.

The Users tab opens.
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2. Select Add.

A new user is added to the Users list.

3. Configure the User section: 

· In the Name field, enter a name for the user. 

The default is New User 1.

· In the E-Mail field, enter the email address where the user will receive Incoder status notifications. 

· In the Location field, enter the location of the user, server, etc. 

For example, Rack Room 01.

· In the Phone # field, enter the phone number of the user.

· In the Description field, enter a brief descriptor for the user, such as their title or position.
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4. Select OK.

The details are added to the user in the Users list.

5. Repeat this procedure for as many users as necessary.



Clips Workflow User Guide (v12.5) XPression INcoder • 84

Projects

Use the following procedures to add and configure as many INcoder projects as needed. 

This section describes how to:

Add a new XPression INcoder project

Configure the Notify Users on Completed settings

Configure the Notify Users on Failure settings

Apply the New Project settings

To add a new XPression INcoder project:

1. In the Configuration Manager, go to the Projects tab.

The Projects tab opens. 

Projects filter which users have access to certain clips.



85 • XPression INcoder Clips Workflow User Guide (v12.5)

2. Select Add.

A New Project is added to the Project List.

3. Configure the Project section: 

· In the Name field, enter a project name. 

The default name is New Project 01.

· In the Description field, enter a brief descriptor for the project.

4. Configure the Recall ID section: 

· Select the Assign auto-incrementing Recall IDs checkbox to automatically assign incrementing
Recall IDs to clips for the selected project when no Recall ID has been assigned via the Filename
parsing settings in the Watch folder.

· In the Starting ID field, enter or select the Recall ID number at which to begin assigning the auto-
incrementing Recall ID numbers to clips. 

· Select the Reset ID button to reset the next ID to be the new starting ID.
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To configure the Notify Users on Completed settings:

1. Go to the Notify Users on Completed tab.

2. Select a user from the Available users list, and then select Add.

The user is added to the Allocated users list.

3. In the Project Details section, scroll down to the Email Template settings and from the Email
Template drop-down, select the template that will be used for the outgoing status email. 

The options are:

·  Select <none> to use no template and receive no email notifications.

·  Select sample-completed.html to use the sample-completed HTML template for the notification. 

·  Select sample-failed.html to use the sample-failed HTML template for the notification.

«Custom templates can be added to the EmailTemplates folder. Find the EmailTemplates folder in

C:\Program Files (x86)\XPression INcoder.

4. Configure the batch notification settings:

· Select the Notify in batch every checkbox to notify users of multiple successful transcodes in bulk, at
the time interval entered in the minutes field. 

· Select the Notify in batch when project queue empties checkbox to notify users of multiple
successful transcodes, once the queue of videos being transcoded in the INcoder Tasks list is empty. 

· In the Batch limit field, enter or select a limit on the number of ingested files that are included in the
batch for the notification.

If both batch notification options are selected, the queue notification option will still occur even if it
occurs before the batch notification time interval.
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5. Select OK.

To configure the Notify Users on Failure settings:

1. Go to the Notify Users on Failure tab.

2. Select a user from the Available users list, and then select Add.

The user is added to the Allocated users list.

3. In the Project Details section, scroll down to the Email Template settings and from the Email
Template drop-down, select the template that will be used for the outgoing status email.  

The options are:

·  Select <none> to use no template and receive no email notifications.

·  Select sample-completed.html to use the sample-completed HTML template for the notification. 

·  Select sample-failed.html to use the sample-failed HTML template for the notification.

«Custom templates can be added to the EmailTemplates folder. Find the EmailTemplates folder in

C:\Program Files (x86)\XPression INcoder.

4. Configure the batch notification settings:

· Select the Notify in batch every checkbox to notify users of multiple failed transcodes in bulk, at the
time interval entered in the minutes field.

· Select the Notify in batch when project queue empties checkbox to notify users of multiple failed
transcodes, once the queue of videos being transcoded in the Tasks list is empty. 

· In the Batch limit field, enter or select a limit on the number of ingested files that are included in the
batch for the notification.
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If both batch notification options are selected, the queue notification option will still occur even if it
occurs before the batch notification time interval.

5. Select OK.

To apply the new project settings:

1. Once the project settings have been configured and the user notification settings have been set, select
OK.

The Projects list is updated.

2. Repeat this procedure for as many projects as necessary.
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Targets

Use the following procedure to add and configure as many INcoder targets as needed.

To configure destination targets for clips:

1. In the Configuration Manager, go to the Targets tab.

The Targets tab opens. 
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2. Select Add.

A new target is added to the Targets list.
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3. In the Target section, in the Name field, enter a name for the new target. 

The default is New Target 1.

4. In the Details section, from the Type drop-down, select the destination type for the target. 

The options are:

· Folder — send encoded clips to a destination folder.

Ø In the Folder field, select Browse to choose a folder, or enter the file path to a folder.

If using a network drive, enter the full network path as opposed to the mapped drive letter. For
example, \\srvtor02\Clips\Transfer as opposed to G:\Transfer.

· Clip Store — send encoded clips from the Watch Folder to the XPression Clip Store Manager.

Ø In the Host field, enter an IP address for the Clip Store Manager location, or use localhost
(default) if the Clip Store Manager is on the same machine as INcoder.

Ø In the Port field, enter or select the port number for the Clip Store Manager location.  

      The default is 9595.

«To use the Clip Store option, XPression Clips must be purchased and installed separately.

5. Select OK.

The settings are added to the Targets list.

6. Repeat the procedure for as many targets as necessary.
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Processors

Processors are used to delegate the targets used for a source. Use the following procedures to add, and
configure as many INcoder processors as needed.

«If you are using XPression Tessera, you will need to configure the Region Mapping tab to split clips

that are larger than HD and UHD resolutions and need to be divided into multiple segments in order to be
spread across multiple render engines. 

See To configure Region Mapping for use with XPression Tessera for instructions.

This section describes how to:

Configure XPression INcoder Processors

Configure Region Mapping for use with XPression Tessera

To configure XPression INcoder processors:

1. In the Configuration Manager, go to the Processors tab.

The Processors tab opens.
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2. Select Add.

A New Processor is added to the Processors list.

3. In the Processor section, in the Name field, enter a name for the processor. 

The default is New Processor 1.

4. In the Options section, configure the following options: 

· Select the Re-encode files that are already in the XPression codec checkbox to force XPression
encoded files to be re-encoded.

· Select the Re-encode still images as TGA for faster playback checkbox to re-encode and convert
all types of still images (.JPG, .TIFF, .PNG, etc.) as .TGA files for faster loading. 

This option uses more disk space.

· Select the Render clip proxies for MOS workflows checkbox to generate proxies of the clips being
transcoded. 

The proxies are used to preview the clips in the HTML5 MOS plugin. 

· Select the Fail unless clip dimensions are exactly checkbox to force the processor to only handle
clips of a specified dimension or fail otherwise; in the fields, enter or select the width and height for
specific clip dimensions for the processor to enforce.

· Select the Reject Clips with dimensions larger than checkbox to enable INcoder to reject clips
larger than a specified dimension; in the fields, enter or select the maximum width and height that
INcoder will accept. 

· Select the Fail unless clip frame rate is and from the drop-down select the frame rate you want to
use. This will prevent a clip from running if it has a different frame rate than the one specified.
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5. In the XPression Codec Settings section, configure the following options: 

Select a Bit Depth of 8 bit or 10 bit.

· Select the Force Quality Level checkbox to force the quality level entered or selected in the field.

· Select the Force Color Space checkbox to force the color setting selected from the drop-down.

· Select the Force Gamma Curve checkbox to force the gamma curve setting selected from the drop-
down.

6. In the Targets tab, select a target from the Available targets list, and then select Add.

The target is added to the Allocated targets list. 

«If you are using  XPression Tessera, skip forward to the procedure To configure Region Mapping for

use with XPression Tessera, if not, continue with this procedure.  

7. Select OK to add the processor and its target settings.

8. Repeat this procedure for as many processors as necessary.

Alternatively, choose an existing processor and select Duplicate to create a duplicate of the selected
processor.
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To configure region mapping for use with XPression Tessera: 

1. In the Configuration Manager, in the Processors tab, go to the Region Mapping tab.

2. Scroll to the bottom of the Region Mapping tab and select Add Region. 

Alternatively, right-click in the Source To Destination Mapping list and select Add Region from the
shortcut menu.
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A new region mapping is added to the Source To Destination Mapping list.

3. In the Source To Destination Mapping list, configure the mapping: 

· In the Name column, select to enter a name for the new region.

· In the Src X column, select to enter or select the starting point within the clip dimensional coordinates
along the X-axis for the source.

Src X is measured from the upper-left corner of the clip that is added.

· In the Src Y column, select to enter or select the starting point within the clip dimensional coordinates
along the Y-axis for the source.

Src Y is measured from the upper-left corner of the clip that is added.

· In the Width column, select to enter or select the width of the region at which the clip segment will be
rendered.

· In the Height column, select to enter or select the height of the region at which the clip segment will
be rendered.

«The section/segments do not have to be symmetrical, each segment can have its own unique

dimension.

· In the Dest X column, select a cell to enter or select a region along the X axis within the clip as the
destination.

· In the Dest Y column, select a cell to enter or select a region along the Y-axis within the clip as the
destination.

· In the Dest Width column, select a cell to enter or select the scale of the width of the region.

· In the Dest Height column, select a cell to enter or select the scale of the height of the region.



97 • XPression INcoder Clips Workflow User Guide (v12.5)

4. Select the Include Audio checkbox to include the clip audio with the region mapping configuration. 

In most cases, this would only need enabling on one segment.

5. In the Output Name column, click to enter an output name macro if necessary.

6. In the Recall ID column, click to enter a Recall ID macro if necessary. 

For example, %name%_1, %id%_1

The Recall ID will match the name when the When recall ID is empty, use filename as Recall ID
checkbox is enabled in the Sources tab.

7. Select OK to save your region mappings.

8. Repeat this procedure for as many processors as necessary.

To configure sub regions:

1. In a mapping, right-click and select Add Sub Region to configure a sub-clip if necessary. 

Sub-clips use a portion of the original clip. 

2. Configure the Sub Region fields:

· In the Dest X column, select a cell to enter or select the region within the clip along the X-axis for the
destination.

· In the Dest Y column, select a cell to enter or select the region within the clip along the Y-axis for the
destination.

· In the Dest Width column, select a cell to enter or select the scale of the width of the sub region.

· In the Dest Height, column, select a cell to enter or select the scale of the height of the sub region.

3. Select OK to add the processor and its target settings.

4. Repeat this procedure for as many processors as necessary.

Alternatively, choose an existing processor and select Duplicate to create a duplicate of the selected
processor.
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Sources

Sources let you add Watch Folders and assign processors to them. Watch Folders are where clips are
added for encoding. Use the following procedures to add and configure as many INcoder sources as needed.

This section describes how to:

Add a new source to the INcoder Manager

Configure source settings

Configure parsing options

Configure Recall ID parsing

Configure the default clip store metadata

Designate source folders

Apply new source configurations

To add a new source to the INcoder Manager:

1. In the Configuration Manager, go to the Sources tab.

The Sources tab opens. 
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2. Select Add.

A New Source is added to the Sources list.

Currently, Watch Folder is the only available option and is enabled by default. 

To configure settings: 

1. In the Source section, in the Name field, enter a name for the source. 

The default is New Source 1.

2. In the Folder field, enter a file path to a folder or Browse to select a folder where INcoder will look for
files to encode and send to the target.

3. Select the Use file system change notification checkbox to have any file changes to the source
folders reflected in INcoder immediately.

4. Select the Scan for changes every checkbox, and then in the field, enter or select the frequency that
INcoder scans the source for any changes.

5. Select the File size should not change for at least checkbox, and then in the field, enter or select the
amount of time for INcoder to wait before the encoding of a file begins. 

This is helpful with larger files where transferring might take a little longer.

6. From the Processor drop-down, assign a processor to the selected source. 

The processor dictates the target of the selected source.

7. From the Project drop-down, assign a project to receive status notifications regarding clips in the
selected source.
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8. From the Relative Priority drop-down, assign a priority level to the source folder. 

The default is 0.

The order of priority ranges from -5 (low) to 0 (normal) to +5 (high). This is helpful if you have multiple
sources, some of which are of a higher priority than others. Files from the higher priority sources will
transcode before files from lower priority sources.

To configure parsing options:

1. In the Parsing Options section, in the File Extension Filter field, enter file extensions accepted for
transcoding by INcoder. 

All file extensions need to be listed with an asterisk (*) in front of the file extension and a semi-colon (;)
between different file types. 

INcoder currently supports MOV, AVI, JPG, PNG, TGA, and TIF files. Any unlisted file type is
immediately blocked.

2. In the Exclude files containing field, enter any keywords, IDs, etc. for INcoder to exclude from
transcoding.

3. Select the Regular Expression checkbox to search a sequence of characters that specify a search
pattern in the text.

To configure Recall ID parsing:

1. In the Recall ID Parsing section, select the Treat leading numbers in filename as Recall ID
checkbox to use any numbers before the filename text, and the file extension as Recall IDs.

2. Select the Treat trailing numbers in filename as Recall ID checkbox to use any numbers between
the filename text and the file extension as Recall IDs.

If Treat trailing numbers in filename as Recall ID is selected, then select the Recall ID should be
preceded by underscore checkbox to only use trailing numbers in a filename as Recall IDs if the
numbers are preceded by an underscore.
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3. Select the When Recall ID is empty, use filename as Recall ID checkbox to use the filename to
populate the Recall ID field if no other Recall ID has been explicitly set.

To configure the default Clip Store metadata:

1. In the Default Clip Store Metadata section, select the Assume videos are pre-multiplied (shaped)
checkbox to assume that the videos multiply/shape the fill signal color information by the luminance
information in the key signal.

2. Select the Set Looping Attribute checkbox to enable looped playback on the videos.

3. Select the Set “Hold Last Frame” Attribute checkbox to hold the video on the last frame when playout
has completed. 

This is also used to keep still images that are one frame in size on screen.

4. From the Default Frame Rate drop-down, select a frame rate for the video files in the folder.

«If any of the checkboxes for Assume videos are pre-multiplied (shaped), Set Looping Attribute,

or Set “Hold Last Frame” Attribute have been selected, and you want to turn off those settings for a
particular file, a “FALSE” string needs to be added to the tag in the filename. For example, {LE}FALSE.

The following tags are parsed from the names of files dropped into the Watch Folder:

· {GP} — Recall ID

· {HF} — Hold Last Frame

· {ID} — Recall ID

· {LE} — Loop Enabled

· {LFF} — Lower Field First

· {NA} — Name

· {PG} — Progressive video

· {PM} — Premultiplied/Shaped video

· {UFF} — Upper Field First

For example, a filename of {NA}Snowstorm{GP}1000{LE}{PM}.mov will be given a Name of
Snowstorm, a Recall ID of 1000, and will be set to Looped playback with Shaped video.

To designate source folders:

1. In the Folders section, select the When queued move to checkbox to move transcoding files to a
selected folder when they are queued, and then enter a file path for the folder's destination or select
Browse to select a folder.

2. Select the On failure move to checkbox to move files to the selected folder if the transcoding has
failed, and then enter a file path for the folder's destination or select Browse to select a folder. 

3. Select the On canceled move to checkbox to move transcoding files that have been canceled to the
selected folder, and then enter a file path for the folder's destination or select Browse to select a folder. 
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4. Select the On completion checkbox and choose one of the following options for the files:

· ›Move — Select this option to choose a folder to move the files to upon completion of transcoding, and

then enter a file path for the folder's destination or select Browse to choose a folder.

· Delete — Select this option to delete the files after transcoding is complete.  

5.  Select the Folder for temporary file processing checkbox to temporarily move the files to the chosen
folder while transcoding, and then enter a file path for the folder's destination or select Browse to
choose a folder.

 «If no folder checkboxes are selected and no destination folders assigned, default folders will be

created for these options.

To apply new source configurations:

1. Once the Source settings have been configured and the source folders have been designated, select OK.

2. Repeat this procedure for as many sources as necessary. 

Alternatively, choose an existing source and select Duplicate to create a duplicate of the selected
source.

For more information on:   

· the XPression INcoder, including stopping the INcoder service, refer to the XPression INcoder User Guide.
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XPression INcoder Tasks

Use the XPression INcoder Manager to view the INcoder tasks.

To view the INcoder tasks:

1. On the machine that has the XPression INcoder installed, locate the XPression INcoder folder using the
Start menu.

2. Select INcoder Manager.

The XPression INcoder Manager opens on the Tasks tab.

3. Add a video to the source folder.
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The video appears in the Tasks list and the State is listed as Transcoding.

4. Once the video has finished transcoding, the State lists as Finished and the Progress displays at
100.0%.
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5. If the INcoder shows no tasks in the Tasks list once a video is added to the source folder, verify that the
video type is supported. 

6. If the video type is supported, stop and then restart the INcoder:

To stop the INcoder:

· Select Stop INcoder ( ) from the Windows Start menu.

If the INcoder was successfully stopped, an information message indicates that the XPression INcoder was
successfully stopped.

To restart the INcoder:

· Select Start INcoder ( ) from the Windows Start menu.

If the INcoder has successfully started, an information message indicates that the XPression INcoder was
successfully started.
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Task List Shortcut Menu - INcoder Engine

Right-click on an INcoder engine in the Tasks list to access the INcoder engine shortcut menu:

· Remove > Completed — remove completed clips from the Tasks list for the selected engine.

· Remove > Failed — remove failed clips from the Tasks list for the selected engine.

· Remove > Cancelled — remove cancelled clips from the Tasks list for the selected engine.

Task List Shortcut Menu - Video

Right-click on a transcoded video in the Tasks list to access the video shortcut menu:

· Set Priority — set a priority level for the selected clip. T

The order of priority ranges from -5 (Lowest) to 0 (Normal) to +5 (High). The default is 0.

· Remove — remove the selected clip from the Tasks list.

· Cancel — cancel an in-progress transcoding of a clip.
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Using XPression Clips
The following topics are discussed in this section:

Setting Up Server Channels

XPression Clips Playback Overview

Clip Browser Interface Overview

Using the Clip Browser

Server Channels

Edit Clip/Add Sub Clip

Updating the Thumbnail in the Clip Browser

Creating a 4-Point Loop

Creating a 3-Point Loop

Send a Video or Image to Clip Store Using the Record Client

Preset Event Tracks
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Setting Up Server Channels

The Server Channels are used for previewing and playing out clips.

Before using the Server Channels, they must be configured in the XPression Hardware Setup. Once
outputs have been configured in XPression, use the following procedure to set up the server channels.

A virtual channel should be assigned a real physical output onto which the clip will be played. It is these
virtual channels that the AMP/VDCP Media Control Gateway is controlling.

This section contains the following information:

Adding a Server Channel

Adding a Preview Output to a Server Channel

For More Information on...

· configuring outputs, refer to the XPression User Guide or Help file.
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Adding a Server Channel

1. In XPression, select Edit > Hardware Setup.

The Hardware Setup dialog opens.

2. Select the Server Channels tab.

The Server Channels tab opens.
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3. Select Add to add a server channel.

The Select Server Channel # dialog opens.

4. From the Channel drop-down, select a server channel number and select OK.

The server channel is added to the list.

5. Configure the following as necessary:

· In the Name column, enter a name for the server channel. 

The default is Server Channel #.

· In the Framebuffer column, use the list to select an output framebuffer for the server channel.

· In the Layer column, use the list to select a layer for rendering. The default is 0 (middle).

· In the Server Channel # Options section, select the Cue video clips directly to framebuffer check box
to cue clips to air immediately when dropped on a server channel from the Clip Browser.

6. Repeat steps 3 to 5 to add more server channels as necessary.

7. Select Close to exit the Hardware Setup dialog.
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Adding a Preview Output to a Server Channel

Once a server channel has been created, it can be assigned a dedicated framebuffer as a preview channel in
the Preview & Monitor tab of the Hardware Setup. Real outputs can also be used as framebuffers.

1. In XPression, select Edit > Hardware Setup.

The Hardware Setup dialog opens.

2. Select the Preview & Monitor tab.

The Preview & Monitor tab opens.
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3. Click inside the Assigned Preview Output column of a server channel in the Output list and from the
Assigned Preview Output drop-down, select a framebuffer as the individual preview output.

The selected framebuffer is assigned as the preview output of the selected server channel.

For More Information on...

· creating a server channel, refer to Adding a Server Channel.
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XPression Clips Playback Overview

Clip playback within XPression can be performed in many ways. The most basic is to open the Clip Browser
in the Sequencer and drag clips from the Clip Browser and drop them into the Sequencer. This creates a
take item which can be assigned an output framebuffer and layer, or server channel and layer, and then
played back as a regular take item or placed into a Cued state using the number pad period key [Num pad
.].

Regular XPression graphics can be rendered as a clip which will be sent directly to the Clip Store. By right-
clicking on a take item in the Sequencer and selecting Export Take Item to Video, the Export to Video

dialog box will open and provide the option to render take items into clips transferred to the clip store.

The number of clips that can be played back simultaneously falls under the same performance limitations as
normal XPression scenes with clips (e.g. play back will be dependent on current generation hardware).

While playing back, a timer counts down the remaining time in the clip and a time bar indicates the playback
amount completed:

Many clips can be dragged into a timed sequence group for a pseudo-playlist capability. Dissolves can even
be set on the take items for transitions between the playlist items:

Clips within the Clip Browser can be sorted and filtered using the options in the Advanced Search Options. In
the example image below they were filtered by Project Name:
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Clip Browser Interface Overview

The following screen capture displays the main elements of the Clip Browser interface.

1. Sources — use this area to view and select clip sources.

2. Quick Find/Search Area — use this area to search for clips. It can be expanded for advanced search
options.

3. Clips List — use this list to view the clips and their multiple properties, cue the clips to the server
channels, edit clips, and add sub clips.
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Using the Clip Browser

The Clip Browser is used for dragging and dropping clips onto Server Channels or into the Sequencer as take
items that can then be cued or played out on server channels (instead of a framebuffer). When dragging a
clip into the Sequencer, the take ID assigned uses the recall ID or the next higher available number. The
Clip Browser also allows for editing of clips.

If clips have been sent to the Clip Browser from the Record Client, or if clips have been transcoded by the
INcoder into the Watch Folder, clips will automatically load into the Clip Browser.

The following topics are discussed in this section:

Opening the Clip Browser

Clip Browser Interface
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Opening the Clip Browser

If using the Clips Option for XPression, use the following procedure to open the Clip Browser.

To open the Clip Browser:

1. In XPression, select the Sequencer layout.

2. In the Menu bar, select Display > Clip Browser.

The Clip Browser opens.



117 • Using XPression Clips Clips Workflow User Guide (v12.5)

Clip Browser Interface

The following section describes the Clip Browser window interface.

All Sources lists the Clip Store sources.

Settings select the following options:

· Increase Font Size ( ) — increase the font size of the Clip Browser
list.

· Decrease Font Size ( ) — decrease the font size of the Clip Browser
list.

· Timecode > Use Source Timecode for In/Out points — display the
In/Out points relative to the timecode of the original source clip.

· Show Thumbnail Overlays — overlay an icon on thumbnails of single
frame clips in the Clip Browser to indicate that they are stills.

· Reset Columns to Default — revert the Clip Browser columns to the
default display settings.

Fast Recall enable or disable fast recall through the keyboard number pad (the button
is green when turned on). The number pad Scroll Lock key can also be used
to control fast recall.

Quick Find enter keywords to search for clips listed in the Clip Browser.

Show/Hide    

advanced search options 

show or hide the Advanced Search Options in the Clip Browser.

Reset Filter clear any entries in the fields of the Advanced Search Options.

Filter (read-only) displays the project selected in the Advanced Search Options.

Show all sub clips 

for matching clips

display any sub clips of a clip in the Clip Browser list.

# (read-only) lists the number in the Clip Browser list.

Name (read-only) lists the name of the clip.

In Point (read-only) lists the drop frame timecode starting point for the clip.

Out Point (read-only) lists the drop frame timecode ending point for the clip or still.

Length (read-only) lists the drop frame timecode duration of the clip or still.

Format (read-only) lists the formatting used for the clip.

Thumbnail (read-only) provides a thumbnail image of the clip or still. Thumbnails can be enlarged
by clicking and dragging the right border of the thumbnail column title.
Review a flip book playout of the clip by hovering the cursor over the
thumbnail. The flip book is rendered over a checkerboard pattern so that
the alpha channel is visible unless the clip is full frame. Still image
thumbnails display an icon ( ) indicating that they are still images and not
clips.
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Flags (read-only) if using clips that have been transcoded by the XPression INcoder that
include tags in the filename, this column lists the tags that have been
parsed from the filename of the clip. The possible flags include:

· LE — indicates that looping has been enabled.

· HF — indicates that the clip will hold the last frame.

· PM — indicates that the clip uses premultiplied/shaped video.

Audio Ch (read-only) lists the amount of audio channels embedded in the clip.

Bit Depth (read-only) lists the quality of the signal quantization for the clip.

Recall ID (read-only) lists the ID number for the clip when it is recalled.

Project (read-only) lists the name of the project to which the clip has been added.

Added (read-only) lists the date the clip was added to the project.

Expires (read-only) lists the expiry date for the clip, if applicable.

Codec (read-only) lists the codec format of the clip.

File Ext (read-only) lists the file type of the clip.

Alpha (read-only) provides a thumbnail of the clip with the alpha channel visible (requires the
original clip to be re-ingested or the thumbnail needs to be updated in the
Edit Clip/Add Sub Clip dialog box if the original status indicates <no info>).

First Frame TC (read-only) lists the timecode at the point of the first frame of the clip.

Volume (read-only) lists the volume level of the clip in decibels.
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Advanced Search Options

Name enter the name of a clip to search.

Recall ID enter a recall ID to search.

Source enter a location to search for a clip.

ID Min enter or select a minimum clip ID number to search.

ID Max enter or select a maximum clip ID number to search.

Duration Min enter a minimum duration time to search for the clip.

Duration Max enter a maximum duration time to search for the clip.

Project select a project to search for the clip.

Added Min use the calendar to select a minimum date to search that the clip was added.

Added Max use the calendar to select a maximum date to search that the clip was added.

Expires Min use the calendar to select the minimum expiry date to search for the clip.

Expires Max use the calendar to select the maximum expiry date to search for the clip.

Never Expires search for a clip with no expiry date set.

Audio Ch Min enter or select a minimum amount of embedded audio channels to search for the clip.

Audio Ch Max enter or select a maximum amount of embedded audio channels to search for the clip.

No Audio search for a clip with no embedded audio.

Reset Filter clear all the fields in the Advanced Search Options.
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Clip Browser Shortcut Menu

Right-click on a clip in the Clip Browser to access the Clip Browser shortcut menu.

Cue on Server Channel add the selected clip to the active (focused) server
channel.

Edit open the Edit Clip dialog and edit the settings of
the selected clip.

Add Sub Clip open the Add Sub Clip dialog and create a sub
clip from the selected clip.

Set Recall ID set the recall ID of a selected clip or a range of
selected clips in the Clip Browser using the Set
Recall ID dialog. Use the Set Recall ID dialog to
enter a recall ID to assign to a selected clip or the
starting recall ID for the range of selected clips.
Using the keyboard shortcut Ctrl + R also opens
the Set Recall ID dialog.

Adjust Loop / Hold Last > Enable Looping enable looping for a clip or a range of selected
clips.

Adjust Loop / Hold Last > Disable Looping disable looping for the clip or a range of selected
clips if looping is enabled.

Adjust Loop / Hold Last > Enable Hold Last Frame hold the last frame of the clip or a range of
selected clips when playout ends. Do not select
this function if taking the clip(s) offline
automatically using an out transition.

Adjust Loop / Hold Last > Disable Hold Last Frame disable holding the last frame of the clip or a range
of selected clips when playout ends if holding the
last frame is already enabled.

Add to Sequencer add selected clip or range of clips to the
Sequencer.

For More Information on...

· the Edit Clip dialog and Add Sub Clip dialog, refer to Edit Clip/Add Sub Clip.
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Server Channels

The following screen capture displays the main elements of the Server Channels interface. 

The Server Channels are used in the XPression Sequencer for previewing and playing out clips. The Server
Channels also allow for editing of clips.

1. Transitions / Options — use this section to set the in and out transitions for the clip in the active
server channel and configure the options for the active server channel.

2. Preview — use this window to preview a clip before playout.

3. Server Channel — use this window to view the loaded clip and audio monitors and use the playout
controls to play, pause, skip forward, skip backward, loop, eject or move the position of the clip.
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Opening the Server Channels

If using the Clips Option for XPression, use the following procedure to access the Server Channels.

To open the server channels:

1. In XPression, open the Sequencer layout.

2. In the Menu bar, select Display > Server Channels.

The Server Channels window opens.
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Loading a Clip in the Server Channels

For clips to load in the Server Channels window, server channels must be configured in the Server
Channels tab of the XPression Hardware Setup. See Setting Up Server Channels.

To load a clip in the server channels:

1. In the Clip Browser, select a clip.

If clips have been sent to the Clip Browser from the Record Client, or if clips have been transcoded by
the INcoder into the Watch Folder, clips will automatically load into the Clip Browser.

2. Drag and drop a clip from the Clip Browser onto a Server Channel in the Server Channels window.

The clip is added to the Preview channel for the Server Channel (or directly to the Server Channel if
the preview has been disabled in the options).

The clip will be loaded to its pre-configured in point.

3. If loaded in the Preview, select Take to play the clip on air on the Server Channel. 

While a clip is on air, clips can be cued on the Preview channel while still allowing the on air clip to be
controlled and have its timecode and countdown visible.

Server Channel playback controls are provided or the space bar can be used to pause and start
playback.

A realtime proxy of the clip is shown as it plays in the server channel along with audio meters and a time
remaining counter.

Take items or timed groups in the Sequencer can also be dragged onto a server channel for playback.
To preserve the original server channel assignment of a take item, press and hold Ctrl while dragging
and dropping from the Sequencer to a server channel.
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«Clips can also be loaded to a channel by double-clicking them in the Clip Browser. They will be loaded

onto the active server channel, as shown by a cyan outline around the channel. Once a clip is loaded to a
server channel, it can be dragged and dropped from one server channel to another as a duplicate. The
active channel can be changed by double-clicking any other server channel.

Clips can also be dragged and dropped directly from Windows Explorer for situations where the clip is not
loaded into the Clip Store (or there is no Clip Store present).

4. Select the Transition tab to set the in and out transitions for the clip in the active server channel:

5. In the In tab, select a Transition style and Mode:

The options are:

· Cut — select to use an instantaneous transition from the take item to the next take item.

· Dissolve — select to use a gradual transition where a take item dissolves into the next take item. 

Configure the mode for the dissolve:

Ø Fade — select to fade in to, or out from, the clip.

Ø Over Black — select to fade in or out from black.

Ø Additive — select to gradually add light to the clip when transitioning in or out.

Ø Saturate — select to saturate the clip when transitioning in or out.

Ø Desaturate — select transition to desaturate the clip when transitioning in or out.

Ø Invert — select to invert the clip when transitioning in or out.

· Push — select to use a sliding transition where the take item pushes out the previous take item. 

Configure the mode for the push:

Ø Right To Left — select to push from right to left.

Ø Left To Right — select to push from left to right.

Ø Top To Bottom — select to push from top to bottom.

Ø Bottom To Top — select to push from bottom to top.

Ø Bottom Right — select to push to the bottom right.

Ø Top Right — select to push to the top right.

Ø Bottom Left — select to push to the bottom left.

Ø Top Left — select to push to the top left.

· Distort — select to use a transition where a take item is warped out. 

Configure the mode for the distortion:

Ø Diverge — select to use multiple splits in the image in the clip.

Ø Pixelate — select to pixelate the clip.

Ø Sine Wave — select to apply a sine wave pattern to the clip.

Ø Shrink — select to expand the clip from a shrunken image.

Ø Shrink Diff — select to expand the clip from a shrunken image.

Ø Spiral — select to spin the clip.
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6. Select the Reverse checkbox to reverse a Dissolve, Push, or Distort transition.

7. Select the Transition Audio checkbox to transition the audio along with the Take Item.

8. Use the Duration field to enter or select the duration of the transition in number of frames.

9. Select the Out tab and repeat steps 5 to 7 to configure the Transition style and Mode for the out
transition.

10.Select the Cue video clips directly to framebuffer checkbox to cue clips to air immediately when
dropped on a server channel from the Clip Browser or Sequencer.
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Using the Server Channels

To use the server channels:

1. In the Server Channels window, load a clip onto a Server Channel.

2. Select the Transition tab and configure the in and out transition for the clip:

In the In and Out tabs, select an in and out transition for the clip:

· Cut — transition instantaneously to and from the clip.

· Dissolve — the clip gradually dissolves in or out.

· Push — the clip slides in or out.

· Distort — the clip is warped in or out.

3. In the Mode section, configure the Dissolve, Push, and Distort transition mode:

Dissolve 

· Fade — fade in to, or out from, the clip.

· Over Black — fade in or out from black.

· Additive — gradually add light to the clip when transitioning in or out.

· Saturate — saturate the clip when transitioning in or out.

· Desaturate — desaturate the clip when transitioning in or out.

· Invert — invert the clip when transitioning in or out.

Push 

· Right To Left — push from right to left.

· Left To Right — push from left to right.

· Top To Bottom — push from top to bottom.

· Bottom To Top — push from bottom to top.

· Bottom Right — push toward the bottom right.

· Top Right — push toward the top right.

· Bottom Left — push toward the bottom left.

· Top Left — push toward the top left.
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Distort 

· Diverge — use multiple splits in the image in the clip.

· Pixelate — pixelate the clip.

· Sine Wave — apply a sine wave pattern to the clip.

· Shrink — expand the clip from a shrunken image.

· Shrink Diff — expand the clip from a shrunken image.

· Spiral — spin the clip.

· Duration — enter or select the duration of the transition in number of frames.

4. Select the Reverse checkbox to reverse a Dissolve, Push, or Distort transition.

5. Select the Transition Audio checkbox to transition the audio along with the Take Item.

6. Use the Duration field to enter or select the duration of the transition in number of frames.

7. In the Options tab, select the Cue video clips directly to framebuffer checkbox to cue clips to air
immediately when dropped on a server channel from the Clip Browser or Sequencer.

8. Use the playback controls to play out the clip:

 
Eject remove a loaded clip from the server channel.

Back return to the beginning of a clip.

Pause pause the clip.

Play play out the clip.

Forward go to the end of the clip.

Loop continuously play the clip.When this button is green, the loop function is turned on.
Pressing it again will turn off the loop function.

Scrub Bar select and hold the marker to drag it forward or backward along the time bar to
move the clip position to a particular location.

9. Right-click inside the Server Channel and:

· select Adjust Clip Volume to open the Adjust Clip Volume dialog box and adjust the clip volume, if
necessary.

· select Edit Clip to open the Edit Clip dialog and edit a clip, if necessary.

· select Show Viewport to open a separate server channel window.
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Preview

The following section describes the Server Channels preview controls.

Preview (read-only) displays the image thumbnail for the loaded clip.

  Eject
remove a loaded clip from the preview channel.

  Take 
take the clip on air over the server channel and remove it from the preview
channel.

  Auto Take 
automatically take a clip cued on the preview channel when the on air clip has
finished playing. This button is green when the auto take function is on.

Scrub Bar select and hold the marker to drag it forward or backward along the time bar
to move the clip position to a particular location.

Current (read-only) displays the elapsed time of the clip.

Remaining (read-only) displays the time remaining in the clip.

Clip Name (read-only) displays the name of the clip loaded in the preview channel.

Recall ID (read-only) displays the recall ID of the clip loaded in the preview channel.

Server Channels

Server Channel X (read-only) — displays the output configured for the server channel, the selected layer,

the image thumbnail for the loaded clip, and an audio meter.

 
Eject remove a loaded clip from the server channel.

 
Back return to the beginning of the clip.

Pause pause the clip.

 
Play play out the clip.

 
Forward go to the end of the clip.

 
Loop continuously play the clip. When this button is green, the loop function is turned

on. Clicking it again will turn off the loop function.

Scrub Bar drag the marker forward or backward along the time bar to move the clip
position.

Current (read-only) displays the elapsed time of the clip.

Remaining (read-only) displays the time remaining in the clip.

Clip Name (read-only) displays the name of the clip loaded in the server channel.
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Recall ID (read-only) displays the recall ID of the clip loaded in the server channel.

Transition (read-only) displays the transition applied to the server channel.

Server Channels Shortcut Menu

Right-click on a clip in the Server Channels to access the Server Channels shortcut menu.

Adjust Clip Volume — select this to open the Adjust Clip Volume dialog box and adjust the volume of the
clip in decibels. Adjusting the volume of a clip on a server channel will adjust the volume of the clip in the
ClipStore.

Edit Clip — select this to open the Edit Clip dialog box and edit the settings of the selected clip.

For More Information on...

· the Edit Clip dialog, refer to Edit Clip/Add Sub Clip.
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Edit Clip/Add Sub Clip

Use the Edit Clip and Add Sub Clip dialogs to configure metadata for a clip. The Add Sub Clip dialog has
the same interface as the Edit Clip dialog but is used to create a trimmed clip from an existing clip. A video
can have multiple sub-clips defined within it, each with distinctive in/out points. Loading a sub-clip for
playout is identical to loading a normal clip.

· The Edit Clip dialog can be accessed by right-clicking in the Clip Browser window and Server Channels
window.

· The Add Sub Clip dialog can only be accessed by right-clicking in the Clip Browser window.
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Video

This section displays the clip that has been selected for editing or creating a sub clip. The clip is rendered
over a checkerboard pattern so that the alpha channel is visible unless the clip is full frame.

The following actions and commands can be performed:

· Use the timeline marker to select a specific frame in the timeline.

· The video can be scrubbed using the timeline bar; or using common NLE shortcuts like H,J,K to
play/rewind at different speeds.

· During scrubbing, audio can be heard by configuring an Audio Monitor device in the Hardware Setup.

· Right-click inside the Clip, Local Events, or Event Track timeline to access the shortcut menu.

«Event Track timelines are available if global event tracks have been configured in the Clip Store

Manager and added as a processor in the INcoder. They will appear in the timeline as named in the Clip
Store Manager. They can be assigned as local events by selecting Preset Event Track > Copy Events
to Local Event Track from the shortcut menu.

Ø Looping > Set Loop Start — select the current position of the timeline marker as the start of the
video loop.

Ø Looping > Set Loop End — select the current position of the timeline marker as the end of the video
loop.

Ø Looping > Reset Loop — clear the loop settings.

Ø Clear In Point — clear a configured start time for the clip.

Ø Clear Out Point — clear a configured end time for the clip.

Ø Clear In and Out Points — clear the configured start and end times for the clip.

Ø Update Clip Thumbnail — update the thumbnail for the clip to reflect any edits or to use a specific
frame as the thumbnail in the Clip Browser.

Ø Add Event > Rosstalk Event — add a RossTalk event directly onto the clip timeline.

Ø Add Event > Scene Director Trigger — add a Scene Director trigger event directly onto the clip
timeline.

Ø Rename Event — rename a selected RossTalk or Scene Director trigger event on the clip timeline.

Ø Delete Event — delete a selected RossTalk or Scene Director trigger event on the clip timeline.
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Video Controls

Set In Point set the start time of the clip where the timeline marker
has been positioned. Keyboard shortcut ‘I’ can be used to
mark an in point.

Set Out Point set the end time of the clip where the timeline marker has
been positioned. Keyboard shortcut ‘O’ can be used to
mark an out point.

Move current position to in point return to the in point of the clip.

Start playback play the clip.

Move current position to end point go to the end of the clip.

Loop loop the playback of the clip. Press the button a second
time to turn off looped playback.

For More Information on...

· looping, refer to Looping Tab.

Clip Timing (read-only)

Position — indicates the position of the timeline marker in the timeline for the clip.

In — displays the in point for the clip.

Out — displays the displays the out point for the clip.

Length — displays the total duration of the clip in frames.

Duration — displays the time length of the clip.

Source Information (read-only)

Resolution — displays the video format of the source clip.

Frame Rate — displays the frame rate of the source clip.

File Size — displays the file size of the source clip.

Bit Depth — displays the quality of the signal quantization of the source clip.

Audio Channels — displays the amount of embedded audio channels used in the source clip.

Codec UID — displays the type of encoding used for the source clip.

Source TC — displays the timecode of the source clip.

Duration — displays the total duration in frames of the source clip.
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Clip Tab

Name — enter or edit a name for the clip.

Recall ID — enter an ID number for the clip when it is recalled.

Hold Last Frame — hold the last frame of the clip when playout ends. Do not select this checkbox if taking
the clip offline automatically using an out transition.

In Point — enter a starting point for the clip.

Out Point — enter an ending point for the clip.

Audio Level — enter or select a volume level for the clip in decibels. Changing the audio level in the Edit
Clip dialog box will not affect live clips on a Server Channel. However, it will apply to the audio monitor if an
audio monitor is configured in the Hardware Setup.

Source (read-only) — lists the location where the clip is stored.

File Name (read-only) — lists the name and file extension of the clip.

Project — select a project for the clip.

Added (read-only) — lists the date the clip was added to the clip store.

Last Modified (read-only) — lists the date the clip was last edited.

Expires — use the calendar to select an expiry date for the clip, if necessary.

Does not expire — use no expiry date for the clip.

Looping Tab

Enable Looping — enable looping for the clip.

Multi-Point — enable the multi-point loop settings.

Multi-Point Loop Settings 

Use the multi-point loops to create free running 4-point and 3-point loops:

· 4-point loops use a frame in point, a loop section of start and end frames, and a frame out point.

· 3-point loops use a loop section of start and end frames with either a frame in point the same as the loop
start frame or a frame out point the same as the loop end frame.

Loop Start enter a starting frame for the loop within the clip time.

Loop End enter an end frame for the loop within the clip time.

Loop Count enter or select an amount of playbacks the clip will loop before stopping. Use 0 for
infinite looping.

set the start time or end time of the loop at the position of the timeline marker.

skip to the start of the loop.

skip to the end of the loop.
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For More Information on...

· creating a 4-point loop, refer to Creating a 4-Point Loop.

· creating a 3-point loop, refer to Creating a 3-Point Loop.

Additional

Original File Name (read-only) — displays the original name of the file as uploaded.

Premultiplied / Shaped — select this check box to multiply/shape the fill signal color information by the
luminance information in the key signal.

Event Tracks

Event tracks are configured in the Clip Store Manager, added as processors in the INcoder, and then
available to use when editing clips from the Clip Browser. The Event Tracks tab provides a list of available
global event tracks.

Assigned Event Tracks — lists the event tracks assigned to the clip.

Available Event Tracks — lists the available event tracks that can be assigned to the clip.

Add Track — select an available event track and select this button to assign it to the clip.

Remove Track — select an assigned event track and select this button to remove it from the clip.

For More Information on...

· using global event tracks, refer to the XPression Clips Workflow User Guide.

Other

Export — use this list to select one of the following options for exporting a clip:

· To Video — open the Export to Video dialog to save the clip as an AVI or MOV video file.

· Still to Disk — open a save dialog to save a still as a Targa (.TGA), Targa (RLE Compressed) (.TGA),
Portable Network Graphic (.PNG), or JPEG (.JPG) format image file.

· Still to Clipstore — open the Send to Clip Store dialog to send a still to the Clip Store database to be
used within the Clips workflow.

· Interlaced Settings > Frame Based — capture the image file without deinterlacing. This setting works
best for scenes with minimal motion.

· Interlaced Settings > Field (line doubled) — capture the image file with each line doubled. For
example, it will replace field two with a duplicate of field one.

· Interlaced Settings > Field (line interpolated) — capture the image file by interpolating between odd
lines to form even lines.

Save — save the edited clip or sub clip.

Cancel — exit the dialog without saving any changes.
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For More Information on...

· the Export to Video dialog, refer to the XPression Help file.

· opening the Edit Clip window and the Add Sub Clip window from the Clip Browser, refer to Clip Browser
Shortcut Menu.

· opening the Edit Clip window from the Server Channels, refer to Server Channels Shortcut Menu.
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Updating the Thumbnail in the Clip Browser

You can update the thumbnail in the Clip Browser to provide a more representative or preferred image to
illustrate the content of the clip.

1. In the Clip Browser, right-click on a clip and select Edit Clip or Add Sub Clip.

The Edit Clip / Add Sub Clip dialog opens.
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2. In the Edit Clip or Add Sub Clip dialog, move the timeline marker to a desired frame in the timeline.
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3. Right-click inside the timeline and select Update Clip Thumbnail from the shortcut menu.

4. Click Save.

The thumbnail for the clip is updated in the Clip Browser.
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Creating a 4-Point Loop

4-point loops use a frame in point, a loop section of start and end frames, and a frame out point.

To create a 4-point loop:

1. In the Edit Clip / Add Sub Clip dialog, select the Clip tab.

The Clip tab opens.

2. In the In Point field, enter a frame in point.

3. In the Out Point field, enter a frame out point.
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4. Select the Looping tab.

The Looping tab opens.

5. In the Looping tab, select the Enable Looping checkbox.

6. Select the Multi-Point checkbox.

7. In the Multi-Point Loop Settings section:

· In the Loop Start field, enter a frame start for the loop.

· In the Loop End field, enter a frame stop for the loop.

· In the Loop Count field, enter or select the number of times to play out the loop. Enter 0 for infinite
looping.

8. Select Save.

The edited clip is updated in the Clip Browser.
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Creating a 3-Point Loop

3-point loops use a loop section of start and end frames with either a frame in point the same as the loop
start frame or a frame out point the same as the loop end frame.

To create a 3-point loop:

1. In the Edit Clip / Add Sub Clip dialog, select the Clip tab.

The Clip tab opens.

2. In the In Point field, enter a frame in point.

3. In the Out Point field, enter a frame out point.
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4. Select the Looping tab.

The Looping tab opens.

5. In the Looping tab, select the Enable Looping checkbox.

6. Select the Multi-Point checkbox.

7. In the Multi-Point Loop Settings section:

· In the Loop Start field, enter a frame start for the loop.

· In the Loop End field, enter a frame stop for the loop.

· In the Loop Count field, enter or select the number of times to play out the loop. Enter 0 for infinite
looping.

8. Select Save.

The edited clip is updated in the Clip Browser.
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Send a Video or Image to Clip Store Using the Record
Client

Once a recording has been completed it can be sent to the Clip Store database to be used within the Clips
workflow.

1. In XPression, select the Record Client ( ) toolbar icon.

The Record Client dialog opens.
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2. Create a video or capture a still image in the Record Client.

3. Right-click on a video or image thumbnail and select Send to Clip Store from the shortcut menu. 

Multiple videos and images can be selected by using Shift + click or holding Ctrl and selecting individual
videos and images.

«Only XPression codec clips should be sent to the Clip Store.
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4. The Send to Clip Store dialog opens.

5. In the Metadata section, configure the following items:

· Name — enter a new name for the video or image in Clip Store, if necessary.

· Recall ID — enter an identifier to recall the video or image from an external device.

· Project — from the drop-down, select any existing projects from Clip Store or enter a new project
name for the video or image. New projects are automatically added to the Clip Store.

· Looping — select to infinitely replay the video each time it reaches the end.

· Hold Last Frame — select to freeze the video on the last frame after playing.

· Premultiplied (Shaped) — select to multiply/shape the fill signal color information by the luminance
information in the key signal.
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6. Select Transfer Clip.

The video or image file is transferred to the Clip Store. Once the transfer has successfully completed, the
Status is listed as Import Complete, the Progress bar is at 100%, and Destination details are listed.
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Preset Event Tracks

In the Clip Store Manager you can create preset events tracks with RossTalk and Scene Director trigger
events which can be assigned to clips in the clip editor.

XPression INcoder must be configured and connected to the Clip Store in order to assign event tracks to a
processor in the INcoder.

For more information on configuring INcoder, refer to the XPression INcoder User Guide.

To configure the events in the Clip Store Manager:

1. Open the XPression Clip Store Manager.

2. In the Object Browser, select Event Tracks from the Clip Store menu tree.

The Event Tracks section opens in the main window.
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3. Select Add to add an event track.

The New Event Track dialog opens.

4. In the Track Properties section:

· In the Name field, enter a name for the event track.

· In the Description field, enter a brief description for the event track if necessary.

5. Select Add Action and select one of the following as an action for the event:

· RossTalk Event 

· SceneDirector Trigger 

The selected action is added to the Actions list.

6. In the Action Properties section, in the Name field, enter a name for the action.
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7. Select Edit Action to configure the properties of the action.

If a RossTalk action was selected, then the RossTalk Event Properties dialog opens.

If a SceneDirector Trigger action was selected, then the Trigger Event Properties dialog opens.

8. Configure the selected action:

RossTalk Event

9. In the Properties section, from the GPI Board drop-down, select the GPI board to use for the RossTalk
message.

a. From the RossTalk Msg drop-down, select the RossTalk message to use for the event. 

For more information on individual RossTalk commands, refer to the GPI On XPression app note.

b. Select one of the Execute when activated from play direction options:

· Left & Right — execute the event when the play direction of the track is moving left or right.

· Left — execute the event when the play direction of the track is moving left only.

· Right — execute the event when the play direction of the track is moving right only.

Trigger Event

«The Trigger in this scene only option is not supported with event tracks.

10.In the Properties section, do the following:

a. In the Scene Name field, enter the name of the scene with the Scene Director to trigger in other
on-air scenes. 

The wildcard character (*) is supported.

b. In the Scene Director field, enter the name of the Scene Director to trigger from the selected
scene(s).
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c. Select an Action for the Scene Director when triggered:

· Play — play out the tracks in the Scene Director.

· Play Reverse — play out the tracks in the Scene Director in reverse.

· Pause — pause the tracks in the Scene Director.

· Stop — stop the tracks in the Scene Director.

· Play Range — select this to set a play range in frames for the playout. Use the adjacent fields to
enter or select the play range in frames.

d. From the Framebuffer drop-down, select the framebuffer on which the scene will be triggered.

e. Select one of the Execute when activated from play direction options:

· Left & Right — trigger the Scene Director when the play direction of the track is moving forward
or in reverse.

· Left — trigger the Scene Director when the play direction of the track is moving forward only.

· Right — trigger the Scene Director when the play direction of the track is moving in reverse only.

11.Select OK.

The RossTalk Event Properties or Trigger Event Properties dialog closes.

12.In the Timing Options section, in the Time Offset field, enter or select a number of frames to offset
the event and select a Reference Point for the offset:

· From Beginning — apply the time offset from the beginning of a clip.

· From Middle — apply the time offset from the middle of a clip.

· From End — apply the time offset from the end of a clip.

13.Select OK.

The New Event Track dialog closes and the event is added to the Event Track list.
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To assign the event track to a processor in the INcoder:

1. In XPression INcoder, select the Configuration tab.

The Configuration section opens.

2. In the Configuration section, select the Processors tab.

The Processors tab opens.

3. From the Processors list, select a processor.

4. In the Targets section of the selected processor, select the Clip Store that includes the configured event
track(s).

The Clipstore Options (ClipStore) section is displayed.
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5. In the Clipstore Options (ClipStore) section, select Add.

The Add Event Tracks dialog opens.

6. Select an event track from the list and select OK.

The selected event track is added to the Assigned Event Tracks list in the Clipstore Options
(ClipStore) section.
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7. Select the Sources tab.
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The Sources tab opens.

8. From the Sources list, select a source.

9. From the Processors list, select the processor that contains the assigned event track(s) and select OK.
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To add an event track to a clip:

1. In the Clip Browser (or a Server Channel) in XPression, right-click on a clip and select Edit from the
shortcut menu (or press F8).

The Edit Clip dialog opens.
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2. Select the Event Tracks tab.

The Event Tracks tab opens.
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3. In the Event Tracks tab, select an event track from the Available Event Tracks list and select Add
Track.

The event track is added to the Assigned Event Tracks list and appears as an event track in the clip
timeline.

To unassign an event track:

· Select the event track in the Assigned Event Tracks list and select Remove Track.

To assign an event track as a local, editable event:

· Right-click on the event in the Event Track timeline and select Preset Event Track > Copy Events to
Local Event Track. 

A prompt will give the option to keep the original event track or delete it from the timeline. The event will
appear in the Local Events timeline once added. 

The original event track can be added back to the clip anytime by reassigning it through the Event
Tracks tab.
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PBus
The following topics are discussed in this section:

PBus Overview

Configuring PBus and PBus Recalls

PBus Triggers

PBus LEARN Commands

PBus Mapping

Using PBus from a Switcher to Recall Items

Using PBus for XPression Clips
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PBus Overview

PBus (Peripheral Bus) is an industry standard protocol designed to allow production switchers to
communicate with external devices. Most large production switchers have some capability of sending PBus
commands to a device.

XPression supports PBus over standard RS232 or TCP/UDP sockets.

The chassis of some turnkey XPression systems might not include a standard RS232 port. However, it is
possible to use an RS232-USB adaptor.

If the production switcher has an RS422 serial port, then you will require an RS232-RS422 adaptor. This
adaptor will require its own power supply. Generally, the adaptors that are port-powered will not function
for these purposes.

«On an XPression Bluebox system, a limited subset of PBus functionality is available. PBus commands can

be used to trigger take items that have been pre-built in an XPression sequence using either XPression
Designer or Studio. It is not possible to customize the PBus registers actions using Bluebox. Each register
number corresponds to a specific take item number and can not be changed. It is not possible to load the
PBM or PBMS PBus mapping files on Bluebox.
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Configuring PBus and PBus Recalls

Use the Hardware Setup to configure XPression to accept PBus commands. PBus is an industry standard
protocol designed to allow production switchers to communicate with external devices.

To enable XPression to accept PBus commands:

1. In XPression, select Edit > Hardware Setup.

The Hardware Setup dialog opens.

2. Select the GPI / Tally Boards tab.

3. Select Add.

The Add New GPI Board dialog opens.
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4. From the Brand drop-down, select PBus and then select OK.

The PBus Setup dialog opens.

5. In the Settings section, from the State drop-down, select Enabled.

Select Disabled to turn off PBus.

6. Select a communication Mode for PBus:

· Serial RS232 — select to use RS232 to send PBus signals to XPression. 

· TCP — select to use TCP/IP to send PBus signals to XPression. 

· UDP — select to use UDP sockets to send PBus signals to XPression. 

7. Configure the selected mode:

RS232 GPI Settings

· From the Port drop-down, select the Communication port that receives the signals.

· From the Baudrate drop-down, select the communication speed for the signals.

· From the Data Bits drop-down, select the number of bits used to represent one character of data for
the signals.

· From the Parity drop-down, select the method used to check for lost data in a signal.

· From the Stop Bits drop-down, select the number of bits used to indicate the end of a byte in a signal.

· From the Flow Control drop-down, select the data transmission rate controller for a signal.

The flow control can be set to Hardware or None, but it must be set the same in both XPression and
the transmitting device. 

TCP & UDP

· In the Network Settings section, in the TCP Port/UDP Port field, enter or select the communication
port that receives the signals.

8. In the PBus Options section, configure the PBus recall options.

XPression normally does not perform any action when a PBus recall command is issued. Instead, it stores
the recall ID to be used later when a PBus trigger command is issued.
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Clear layer on recall — when this option is selected and a PBus recall command is received, XPression
will look to see which channel and layer that the take item being recalled has been assigned. It will then
immediately clear that layer and channel. However, the take item will not be read to air until such time
as a PBus Trigger command is received to put the item on air. This configuration option is recommended
to be enabled in situations where XPression might be used to play back clips/graphics and to ensure that
as soon the recall command is issued, any previous graphic that might have been left over on the layer
will be removed.

Move sequencer focus on recall — this configuration option can be selected to move the sequencer
focus to the item that is being recalled. This can be useful as a means of generating a preview output
that will show a rendered frame from the item that will be put on air when the PBus trigger command is
received.

Cue item on recall — selecting this option will place the take item into a cued state when the recall
command is received. This is useful when using video clips which might take a few frames to cue.

Video Clips cue directly to framebuffer — selecting this option will cause the video clips from the Clip
Store that are assigned to a PBus register to cue directly onto the hardware output of XPression in a
paused state. When the play command is received, they will begin playing.

Ignore LEARN command — selecting this option will ignore the LEARN command. LEARN stores the clip
currently loaded into a server channel into the PBus register list when the LEARN command is received.

9. From the Data Logger drop-down, select an encoding scheme for the data log. 

The options are:

· None — select this option to use no data logging.

· ASCII — select this option to use ASCII encoding for the data log.

· HEX — select this option to use HEX file formatting for the data log.

· Both — select this option to use both ASCII encoding and HEX file formatting for the data log.

10.Select OK.

The PBus interface is displayed in the GPI Board list.

11.Select Close.

The Hardware Setup dialog closes.

12.Select OK.

The PBus Setup dialog closes and the new PBus interface is added to the GPI Boards table.

For More Information on...

· configuring and working with GPIs, refer to the GPI White Paper available from Ross Video.
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PBus Triggers

XPression supports many PBus Trigger commands.

PBus Trigger Command Description

Trigger 0 – Play Item This trigger can be overridden in the PBus mapping.

Trigger 0 is normally used to play a take item to air. However,
this can be overridden to perform other actions on a per-
register basis. These actions can be configured in the PBus
mapping menu.

Trigger 1 – Take Sequence Item Off-Air Trigger 1 is used to take an item off air (assuming it was
already on air). The item taken off air will be the take item
that was previously recalled using a PBus recall command.

Trigger 2 – Execute GPI Trigger 2 is used to emulate a standard GPI input. In the
XPression Keyboard/GPI Mapping, various actions can be
configured to be executed on a GPI input being triggered. It is
possible to trigger up to 99 different GPIs through PBus. The
GPI number that will be triggered is the number that was
previously recalled using a PBus recall command.

Trigger 3 – Clear Framebuffer Trigger 3 will clear the framebuffer assigned to the device in
the PBus channel configuration. If the channel is set to
<default>, this trigger will clear Channel 1.

Trigger 4 – Clear Framebuffer Channel 2 Trigger 4 will clear the framebuffer assigned to the device in
the PBus channel configuration. If the channel is set to
<default>, this trigger will clear Channel 2.

Trigger 5 – Read Current Sequence Item
to Air 

Trigger 5 will take the currently selected sequence item from
the sequencer to air. It ignores the PBus recall command and
uses whichever item currently has focus in the XPression
sequencer.

Trigger 6 – Resume Channel Trigger 6 will resume all paused graphics currently on the
framebuffer assigned to the device in the PBus Channel
Configuration. If the framebuffer is set to <default>, this will
resume Channel 1.

Trigger 7 – Resume Channel Trigger 7 will resume all paused graphics currently on the
framebuffer assigned to the device in the PBus Channel
Configuration. If the framebuffer is set to <default>, this will
resume Channel 2.

Trigger 8 – Resume Take Item Trigger 8 will resume a single paused take item. The take item
will be the item previously recalled by a PBus recall command.

Trigger 10 – Bank 0 Trigger 10 will change the last recall command into an ID in
the 0-99 range (refer to the Bank 1 command below for more
details).
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PBus Trigger Command Description

Trigger 11 – Bank 1 Trigger 11 is used to allow switchers that can only send PBus
recall commands up to 99 to be able to recall take items with
values of between 100 and 199.

This “bank 1” command will add 100 to the last recalled item
using a PBus recall command. For example; to recall take ID
135 and put it on air, a switcher could send:

· Recall 035

· Trigger 11 (changes the 035 into 135)

· Trigger 0

It is not necessary to switch back to bank 0 after sending a
bank 1 command. XPression will automatically revert to bank
0 for the next PBus recall command.

Trigger 12 – Bank 2 Changes the last PBus recall command into an ID in the 200-
299 range.

Trigger 13 – Bank 3 Changes the last PBus recall command into an ID in the 300-
399 range.

Trigger 14 – Bank 4 Changes the last PBus recall command into an ID in the 400-
499 range.

Trigger 15 – Bank 5 Changes the last PBus recall command into an ID in the 500-
599 range.
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PBus LEARN Commands

When a PBus LEARN command is received from a remote device, XPression will look to the configured server
channel for the PBus device, and if there is a clip currently cued on that server channel it will assign that clip
into the PBus register.

There is an option Ignore LEARN command in the PBus Setup dialog in the Hardware Setup. This
option is useful if you are manually assigning clips to PBus registers and you do not want to
change/overwrite them when storing memories on the production switcher. Most production switchers
automatically send the PBus LEARN command when storing the memory.

For More Information on...

· the PBus LEARN command, refer to the appropriate switcher documentation.
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PBus Mapping

Use PBus mapping to assign clips, functions, scenes, scripts, and other actions and functions to device
registers, and then save and load the maps.

The following procedures are covered in this section:

Configuring PBus Mapping

Assigning an Action to a PBus Register

Remapping a PBus Register

Loading and Saving Maps

Configuring PBus Mapping

Use the PBus Device Configuration dialog to configure the Device IDs and server channels.

To configure PBus Mapping:

1. In XPression, select the Sequence editor.

2. Select Display > PBus Mapping.

The PBus Mapping window opens.

3. Select the Setup Device Configuration ( ) icon.
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The PBus Device Configuration dialog box opens.

4. Select Add to add a Device ID.

A device ID is added to the PBus Device Configuration list. At least one Device ID must be added.
The Device ID is the ID number that will be sent in PBus messages transmitted from the production
switcher.

5. Click inside the Device ID column of the ID and enter or select a different ID number from the default
number, if necessary.

PBus Device IDs must be between 0 and 23.

6. Click inside the Name column of the ID and enter a name to refer to the Device ID. For example,
Device D.

7. Click inside the Server Channel column of the ID and from the drop-down, select a specific output
framebuffer or use the <default> framebuffer.

If the framebuffer is set to anything other than <default> when a PBus recall command is received for a
specific Device ID, the item will be played on the selected framebuffer. If <default> is selected, the
item will be played on the framebuffer for which the original take item was configured. When a clip from
the Clip Store is assigned to a register and <default> was selected for the Server Channel, the first
device configured will use Server Channel 1, the next will use Server Channel 2, etc.

If XPression does not have the Clips option, then the Server Channel configuration column will be
missing and all take items will be cued to the channel assigned to them through the Sequencer.
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8. Select OK.

The Device IDs are added as tabs at the bottom of the PBus Mapping window under the assigned
device names. If there are no tabs added, then a Device ID was not added to the PBus Device
Configuration list.
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Assigning an Action to a PBus Register

Each device has a list of 4095 registers which can be recalled through PBus.

«Some switchers can only support the first 99 registers.

Each PBus register can be assigned an action that will be executed after the register is recalled and Trigger
0 is received. The default action for each register is to play the corresponding Take Item with the same
number as the PBus register.

To assign an action to a PBus register:

1. In the PBus Mapping window, select an action from the actions list to the right of the devices.
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2. Drag and drop the action onto a register.

The action is added to the register.
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Remapping a PBus Register

To remap a PBus register to play a different take item, the take item can be dragged and dropped from the
sequencer onto the register in the PBus Mapping window or you can enter or select a different take ID using
the Take ID box in the Recall Take Item section of the PBus Mapping window.

To remap a PBus register to play a different take item, the take item can be dragged and dropped from the
sequencer onto the register in the PBus Mapping window or you can enter or select a different take ID
using the Take ID field in the Recall Take Item section of the PBus Mapping window.

To remap a PBus register using drag and drop from the Sequencer:

1. In the Sequencer, select a take item from the Take ID list.
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2. Drag and drop the take item onto a register in the PBus Mapping window.
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The take item is added to the register.
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To remap a register using the Take ID field:

1. In the PBus Mapping window, select a register number from the devices to the left of the actions list.

2. In the Recall Take Item section, in the Take ID field, enter or select a take item to add to the selected
register.

The take item is added to the selected PBus register.
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Loading and Saving Maps

PBus maps are not loaded and saved with XPression projects. They are loaded and saved to disk as .pbm or
.pbms files using the PBus Mapping window. The .pbm file extension is used for a single PBus map and the
.pbms file extension is used for multiple PBus maps.

Use the following PBus Mapping window toolbar icons to load and save PBus maps:

Load — open a file browser to select a PBus map or multiple PBus maps to load.

Save All — save multiple PBus maps to disk.

Save — save a single PBus map to disk.
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Using PBus from a Switcher to Recall Items

«Consult the switcher documentation for a complete description of how to use PBus with your particular

manufacturer/model. This section is only intended to provide some background information and tips.

Normally switchers will send a PBus recall command when an EMEM is recalled. The following procedure is
an example using take item 0005.

To recall and play a specific take item from XPression:

1. In XPression, in the Sequencer, create a take item and give it an ID of 0005.

2. Create an EMEM/Memory on the switcher and store it as EMEM 5.

3. Within EMEM 5, ensure that you have enabled the sending of PBus commands.

4. Within the timeline for EMEM 5, issue a PBus Trigger 0 command.

When EMEM 5 is recalled, it will send a PBus recall 5 command to XPression. 

This command will not yet do anything (unless the configuration options discussed in the Configuring the
PBus Interface and PBus Recalls section are enabled).

When the timeline is run, the switcher will send a PBus Trigger 0 command. At this time, XPression will
put take item #5 on the output channel/layer previously assigned to that item in the sequencer.

«There may be several frames of delay between issuing the Trigger 0 command and when the video

for the item appears on the SDI output of XPression. This is normal and should be accounted for inside of
the timeline on the switcher. For example, you will need a delay between the issuing of Trigger 0 and
when the keyer containing the XPression is keyed onto the PGM output.

5. To recall different take items, copy the timeline on the switcher into different switcher registers.
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Using PBus for XPression Clips

Firstly, the PBus configuration must be set to assign a PBus device ID to a specific server channel. This
controls the server channel onto which PBus commands to a device will load the clip. Valid device IDs are
from 0 to 23.

By default, every PBus register (0 to 4095) will cue/play the corresponding take item with that ID number.
However, clips from the Clip Browser can be assigned to a PBus register simply by dragging them from the
Clip Browser onto a PBus register. Alternatively, various actions (same ones accessible in the keyboard
mapping menu) can be assigned to a PBus register by dragging them from the action list on the right to a
PBus register. This is useful for assigning scripts or actions like Take Next/Clear Channel, etc. to a PBus
register. Right-click on a register with a clip and select Find Clip in Clip Browser to find a clip or select a
different clip in the Clip Browser.

A PBus register map can be saved to disk to a file using the .PBM extension, or maps for all devices can be
saved to a .PBMS file. Maps can be loaded from these PBM files or from a specific format of XML file. When
using the XML file import, it will assign clips to PBus registers using their recall ID from the clip database.
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Using PBus for XPression Clips with Recall IDs

The PBus map contains a column named Recall ID.

If a clip in the Clip Store exists with that recall ID, it will be assigned to that PBus register. A clip’s recall ID
can also be entered into the column to assign it to the respective register. The PBus register will always
recall the clip with that specific recall ID, so if a new clip is ingested with a matching recall ID, the PBus
register will recall the new clip instead. If the clip is manually edited and the recall ID is changed or
removed, the PBus register will no longer recall that clip.

A similar behavior exists when dragging a clip with a recall ID into the PBus register; meaning that the PBus
register is bound to a specific recall ID and not to a specific clip. Holding Ctrl-Shift and dragging a clip onto

a PBus register will link the clip with the PBus register, and it will not be replaced regardless of a clip with a
duplicate recall ID being ingested.

For More Information on...

· PBus, refer to the XPression User Guide or Help file.
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